Chapter 1    Hardware Setup

Unpack Your New Router .............................................. 8
Prepare the Router for Installation ............................ 9
Hardware Features ....................................................... 9
  Label ...................................................................... 10
  Back Panel ................................................................. 10
  Front Panel ................................................................. 11
Position Your Wireless Router ...................................... 12

Chapter 2    Getting Started with NETGEAR Genie

Router Setup Preparation ............................................ 14
  Use Standard TCP/IP Properties for DHCP ............. 14
  Gather ISP Information ................................................ 14
  Wireless Devices and Security Settings ...................... 14
Types of Logins and Access ......................................... 14
NETGEAR Genie Setup .................................................. 15
Use NETGEAR Genie after Installation ......................... 16
Upgrade Router Firmware ............................................ 16
Router Dashboard (Basic Home Screen) ......................... 17
Add Wireless Devices or Computers to Your Network ...... 17
  Manual Method .......................................................... 18
  Wi-Fi Protected Setup (WPS) Method ......................... 18

Chapter 3    Genie Basic Settings

Internet Setup ............................................................. 20
Internet Setup Screen Fields ........................................ 20
Attached Devices ......................................................... 22
Parental Controls ......................................................... 23
ReadySHARE USB Storage ............................................ 23
Basic Wireless Settings ................................................ 24
  Wireless Settings Screen Fields ............................... 25
  Change WPA Security Option and Passphrase ............. 26
Guest Networks .......................................................... 27
  Guest Network Wireless Security Options ................... 28
Chapter 4  Genie Advanced Home

Setup Wizard .......................... 31
WPS Wizard .......................... 32
Setup Menu .......................... 33
WAN Setup .......................... 34
  Default DMZ Server .................. 35
  Change the MTU Size ................. 35
LAN Setup .......................... 37
  LAN Setup Screen Settings ........... 38
  Use the Router as a DHCP Server ... 38
  Address Reservation ................ 39
  Quality of Service (QoS) Setup ...... 40

Chapter 5  USB Storage

USB Drive Requirements .................. 46
ReadySHARE Access .................. 46
File Sharing Scenarios ................. 46
Basic Settings ....................... 48
  Add or Edit a Network Folder ........ 50
USB Storage Advanced Settings ........ 51
Safely Remove a USB Drive .......... 53
Media Server Settings ................. 53
Specify Approved USB Devices ....... 54
Connect to the USB Drive from a Remote Computer ........ 54
  Access the Router’s USB Drive Remotely Using FTP ....... 55

Chapter 6  Security

Keyword Blocking of HTTP Traffic ............ 57
  Delete a Keyword or Domain .......... 57
  Specify a Trusted Computer .......... 57
Block Services (Port Filtering) ............ 58
Schedule Blocking .................... 59
Security Event Email Notifications ........ 60

Chapter 7  Administration

Upgrade the Router Firmware .................. 63
View Router Status ........................ 64
  Router Information .................... 64
Internet Provider (WAN) Setup ............ 64
  Wireless Settings (2.4 GHz) and Wireless Settings (5 GHz) ....... 67
  Guest Network (2.4 GHz) and Guest Network (5 GHz) ............... 67
View Logs of Web Access or Attempted Web Access .......... 68
Cannot Log In to the Router ........................................ 109
Cannot Access the Internet ......................................... 110
Changes Not Saved .................................................. 111
Incorrect Date or Time ............................................. 111
Wireless Connectivity ............................................... 111
Wireless Signal Strength ........................................... 112

Appendix A  Supplemental Information

Factory Default Settings ........................................... 114
Technical Specifications ......................................... 116

Appendix B  Notification of Compliance

Index
Hardware Setup

Getting to know your router

The N600 Wireless Dual Band Gigabit Router WNDRMAC provides high-performance wireless Internet access. Its dual band design provides the maximum flexibility for a home network. This is because the router contains two different types of wireless radios to support connections on both 2.4 GHz and 5.0 GHz wireless links.

For help installing your new router, see the installation guide that came in the box.

This chapter contains the following sections:

- Unpack Your New Router
- Prepare the Router for Installation
- Hardware Features
- Position Your Wireless Router

For information about ReadySHARE features in your product, see Chapter 5, USB Storage and www.netgear.com/readyshare.

For more information about the topics covered in this manual, visit the Support website at http://support.netgear.com.
Unpack Your New Router

Your box should contain the following items:

- N600 Wireless Dual Band Gigabit Router WNDRMAC
- A slide-on stand for your router
- AC power adapter (plug varies by region)
- A yellow Ethernet cable
- NETGEAR Installation Guide with cabling and router setup instructions

If any of the parts are incorrect, missing, or damaged, contact your NETGEAR dealer. Keep the carton, including the original packing materials, in case you need to return the product for repair. See Position Your Wireless Router on page 12 for information about where to place and how to position your router.

Figure 1. Review the box contents
Prepare the Router for Installation

1. Carefully remove the protective film from the top of your router.
2. Set up your router by aligning the arrow on the base with the arrow on the back of the case, and sliding the router onto the base.

![Figure 2. Align arrow on base with arrow on case back](image)

3. Place your router in an area suitable for installation (near an AC power outlet and accessible to the Ethernet cables for your wired computers). See *Position Your Wireless Router* on page 12 for more information.

Hardware Features

Before you cable your router, take a moment to become familiar with the label and the front and back panels. Pay particular attention to the LEDs on the front panel.
Label

The label on the bottom of the router shows the router’s Restore Factory Settings button, preset wireless information, MAC address, and serial number.

Figure 3. Information on the router label

See Basic Wireless Settings on page 24 for information about preset security. See Factory Default Settings on page 114 for information about the Restore Factory Settings button and the factory setting values.

Back Panel

The back panel has the On/Off button and the port connections shown in the following figure:

Figure 4. Back panel features

- The four local (LAN) 10/100/1000 Mbps Ethernet ports are for cabling the router to local computers.
- The Internet (WAN) 10/100/1000 Mbps Ethernet port is for cabling the router to a cable or DSL modem.
- The USB 2.0 port (backward compatible to USB 1.0/1.1) can be used to attach a USB storage device.
Front Panel

The router front panel has the LEDs and icons shown in the figure. Note that the Wireless and WPS icons are buttons.

![Figure 5. Front panel LEDs and buttons](image)

The front panel has five status LEDs that you can use to monitor and verify various conditions. There are also two buttons on the right (or at the bottom if the router is in its stand). The LEDs are described in the following table.

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power/Test</td>
<td>• <strong>Solid amber</strong>. The router is starting up after being powered on.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Solid green</strong>. The router startup has completed and the router is ready.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Off</strong>. Power is not supplied to the router.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Blinking green</strong>. The firmware is corrupted. See <a href="http://www.netgear.com/support">www.netgear.com/support</a>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Blinking amber</strong>. The firmware is upgrading, or the Restore Factory Settings button was pressed.</td>
</tr>
<tr>
<td>Wireless</td>
<td>• <strong>Solid blue</strong>. The wireless radio is operating in either 2.4 GHz or 5 GHz mode.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Off</strong>. The wireless radios are off for both 2.4 GHz and 5 GHz.</td>
</tr>
<tr>
<td>USB</td>
<td>• <strong>Solid green</strong>. The USB device had been accepted by the router and is ready to be used.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Blinking green</strong>. The USB device is in use.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Off</strong>. No USB device is connected, or the Safely Remove Hardware button has been clicked and it is now safe to remove the attached USB device.</td>
</tr>
<tr>
<td>Internet</td>
<td>• <strong>Solid green</strong>. An IP address has been received; ready to transmit data.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Solid amber</strong>. The Ethernet cable connection to the modem has been detected.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Off</strong>. No Ethernet cable is connected to the modem.</td>
</tr>
<tr>
<td>LAN</td>
<td>• <strong>Solid green</strong>. A LAN port has detected a 1 Gbps link with an attached device.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Solid amber</strong>. One or more LAN ports have detected a 10/100 Mbps link with an attached device.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Off</strong>. No link is detected on any of the 4 LAN ports.</td>
</tr>
</tbody>
</table>

The WLAN and WPS buttons toggle the WLAN and WPS functions on and off.

- **WLAN On/Off button**. Pressing and holding the wireless LAN button for 2 seconds turns the 2.4 GHz and 5 GHz wireless radios on and off. If the Wireless LED is lit, then the...
wireless radio is on. If the Wireless LED is off, then the wireless radios are turned off and you cannot connect wirelessly to the router.

- **WPS** button. You can use this button to use WPS to add a wireless device or computer to your wireless network. The LED below the WPS button blinks green when the router is trying to add the wireless device or computer. The LED stays solid green when wireless security is enabled in the router.

### Position Your Wireless Router

The router lets you access your network from virtually anywhere within the operating range of your wireless network. However, the operating distance or range of your wireless connection can vary significantly depending on the physical placement of your router. For example, the thickness and number of walls the wireless signal passes through can limit the range. For best results, place your router:

- Near the center of the area where your computers and other devices operate, and preferably within line of sight to your wireless devices.
- So it is accessible to an AC power outlet and near Ethernet cables for wired computers.
- In an elevated location such as a high shelf, keeping the number of walls and ceilings between the router and your other devices to a minimum.
- Away from electrical devices that are potential sources of interference, such as ceiling fans, home security systems, microwaves, PCs, or the base of a cordless phone or 2.4 GHz cordless phone.
- Away from any large metal surfaces, such as a solid metal door or aluminum studs. Large expanses of other materials such as glass, insulated walls, fish tanks, mirrors, brick, and concrete can also affect your wireless signal.
- With the antenna in a vertical position to provide the best side-to-side coverage or with the antenna in a horizontal position to provide the best up-and-down coverage, as applicable.

Also be aware that when you use multiple access points, it is better if adjacent access points use different radio frequency channels to reduce interference. The recommended channel spacing between adjacent access points is 5 channels (for example, use Channels 1 and 6, or 6 and 11).

---

**Note:** Failure to follow these guidelines can result in significant performance degradation or the inability to wirelessly connect to the router.
This chapter explains how to use the NETGEAR Genie to set up your router after you complete cabling as described in the installation guide and in the previous chapter in this book.

This chapter contains the following sections:

- *Router Setup Preparation*
- *Types of Logins and Access*
- *NETGEAR Genie Setup*
- *Use NETGEAR Genie after Installation*
- *Upgrade Router Firmware*
- *Router Dashboard (Basic Home Screen)*
- *Add Wireless Devices or Computers to Your Network*
Router Setup Preparation

You can set up your router with the NETGEAR Genie automatically, or you can use the Genie menus and screens to set up your router manually. However, before you start the setup process, you need to have your ISP information on hand and make sure the laptops, PCs, and other devices in the network have the settings described here.

Use Standard TCP/IP Properties for DHCP

If you set up your computer to use a static IP address, you need to change the settings so that it uses Dynamic Host Configuration Protocol (DHCP).

Gather ISP Information

If you have DSL broadband service, you might need the following information to set up your router and to check that your Internet configuration is correct. Your Internet service provider (ISP) should have provided you with all of the information needed to connect to the Internet. If you cannot locate this information, ask your ISP to provide it. When your Internet connection is working, you no longer need to launch the ISP’s login program on your computer to access the Internet. When you start an Internet application, your router automatically logs you in.

- The ISP configuration information for your DSL account
- ISP login name and password
- Fixed or static IP address settings (special deployment by ISP; this is rare)

Wireless Devices and Security Settings

Make sure that the wireless device or computer that you are using supports WPA or WPA2 wireless security, which is the wireless security supported by the router. See Basic Wireless Settings on page 24 for information about the router’s preconfigured security settings.

Types of Logins and Access

There are two separate types of logins that have different purposes. It is important that you understand the difference so that you know which login to use when.

- **Router login** logs you in to the router interface from NETGEAR Genie. See Use NETGEAR Genie after Installation on page 16 for details about this login.
- **ISP login** logs you in to your Internet service. Your service provider has provided you with this login information in a letter or some other way. If you cannot find this login information, contact your service provider.
- **Wireless network key or passphrase.** Your router is preset with a unique wireless network name (SSID) and password for wireless access. This information is on the label located on the bottom of your router.
NETGEAR Genie Setup

NETGEAR Genie runs on any device with a Web browser. It is the easiest way to set up the router because it automates many of the steps and verifies that those steps have been successfully completed. It takes about 15 minutes to complete.

To use the NETGEAR Genie to set up your router:

1. Turn the router on by pressing the On/Off button, if not done yet.
2. Make sure that your device is connected with an Ethernet cable (wired) or wirelessly (with the preset security settings listed on the bottom label) to your router.
3. Launch your Internet browser.
   • If this is the first time you are setting up the Internet connection for your router, the browser automatically goes to http://www.routerlogin.net, and the NETGEAR Genie screen displays.
   • If you already used the NETGEAR Genie, type http://www.routerlogin.net in the address field for your browser to display the NETGEAR Genie screen. See Use NETGEAR Genie after Installation on page 16.
4. Follow the onscreen instructions to complete NETGEAR Genie setup. NETGEAR Genie guides you through connecting the router to the Internet.

If the browser cannot display the Web page:

• Make sure that the computer is connected to one of the four LAN Ethernet ports, or wirelessly to the router.
• Make sure that the router is fully up and running. Its wireless LED should turn on.
• Close and re-open the browser to make sure the browser does not cache the previous page.
• Browse to http://routerlogin.net.
• If the computer is set to a static or fixed IP address (this is uncommon), change it to obtain an IP address automatically from the router.

If the router does not connect to the Internet:

1. Review your settings to be sure that you have selected the correct options and typed everything correctly.
2. Contact your ISP to verify that you have the correct configuration information.
3. Read Chapter 9, Troubleshooting. If problems persist, register your NETGEAR product and contact NETGEAR Technical Support.
Use NETGEAR Genie after Installation

When you first set up your router, the NETGEAR Genie automatically starts when you launch an Internet browser on a computer that is connected to the router. You can use the NETGEAR Genie again if you want to view or change settings for the router.

1. Launch your browser from a computer or wireless device that is connected to the router.

The login window displays:

```
User name: admin
Password: ********
Remember my password
```

3. Enter admin for the router user name and password for the router password, both in lowercase letters.

   Note: The router user name and password are different from the user name and password for logging in to your Internet connection. See Types of Logins and Access on page 14 for more information.

Upgrade Router Firmware

When you set up your router and are connected to the Internet, the router automatically checks for you to see if a newer firmware is available. If it is, a message is displayed on the top of the screen. See Upgrade the Router Firmware on page 63 for more information about upgrading firmware.

Click the message when it shows up, and click Yes to upgrade the router with the latest firmware. After the upgrade, the router restarts.

CAUTION:

Do not try to go online, turn off the router, shut down the computer, or do anything else to the router until the router finishes restarting and the Power LED has stopped blinking for several seconds.
Router Dashboard (Basic Home Screen)

The router Basic Home screen has a dashboard that lets you see the status of your Internet connection and network at a glance. You can click any of the six sections of the dashboard to view more detailed information. The left column has the menus, and at the top there is an Advanced tab that is used to access additional menus and screens.

• **Home.** This dashboard screen displays when you log in to the router.
• **Internet.** Set, update, and check the ISP settings of your router.
• **Wireless.** View or change the wireless settings for your router.
• **Attached Devices.** View the devices connected to your network.
• **Parental Controls.** Download and set up parental controls to prevent objectionable content from reaching your computers.
• **ReadyShare.** If you connected a USB storage device to the router, then it is displayed here.
• **Guest Network.** Set up a guest network to allow visitors to use your router’s Internet connection.
• **Advanced tab.** Set the router up for unique situations such as when remote access by IP or by domain name from the Internet is needed. See Chapter 8, Advanced Settings. Using this tab requires a solid understanding of networking concepts.
• **Help & Support.** Go to the NETGEAR support site to get information, help, and product documentation. These links work once you have an Internet connection.

Add Wireless Devices or Computers to Your Network

Choose either the manual or the WPS method to add wireless devices, and other equipment to your wireless network. See Guest Networks on page 27 for instructions on how to set up a guest network.
Manual Method

1. Open the software that manages your wireless connections on the wireless device (laptop computer, gaming device, iPhone) that you want to connect to your router. This software scans for all wireless networks in your area.

2. Look for your network and select it. If you did not change the name of your network during the setup process, look for the default Wi-Fi network name (SSID) and select it. The default SSID is located on the product label on the bottom of the router.

3. Enter the router password and click **Connect**. The default router passphrase is located on the product label on the bottom of the router.

4. Repeat steps 1–3 to add other wireless devices.

Wi-Fi Protected Setup (WPS) Method

Wi-Fi Protected Setup (WPS) is a standard for easily adding computers and other devices to a home network while maintaining security. To use WPS, make sure that all wireless devices to be connected to the network are Wi-Fi certified and support WPS. During the connection process, the client gets the security settings from the router so that every device in the network has the same security settings.

To use WPS to join the wireless network:

If your wireless device supports WPS (Push 'N' Connect), follow these steps:

1. Press the **WPS** button on the router front panel.
2. Within 2 minutes, press the **WPS** button on your wireless device or follow the WPS instructions that came with the device. The device is now connected to your router.
3. Repeat steps 1–2 to add other WPS wireless devices.
This chapter explains the features available from the Genie Basic Home screen, shown in the following figure:

This chapter contains the following sections:

- Internet Setup
- Attached Devices
- Parental Controls
- ReadySHARE USB Storage
- Basic Wireless Settings
- Guest Networks
Internet Setup

The Internet Setup screen is where you view or change ISP information.

1. From the Home screen, select **Internet**. The following screen displays:

![Internet Setup Screen](image)

The fields that display in the Internet Setup screen depend on whether or not your Internet connection requires a login.

- **Yes.** Select the encapsulation method and enter the login name. If you want to change the login time-out, enter a new value in minutes.
- **No.** Enter the account and domain names, only if needed.

2. Enter the settings for the IP address and DNS server. The default settings usually work fine. If you have problems with your connection, check the ISP settings.

3. Click **Apply** to save your settings.

4. Click **Test** to test your Internet connection. If the NETGEAR website does not display within 1 minute, see Chapter 9, **Troubleshooting**.

Internet Setup Screen Fields

The following descriptions explain all of the possible fields in the Basic Settings screen. Note that which fields display in this screen depends on whether or not an ISP login is required.

**Does Your ISP Require a Login?** Answer either yes or no.

These fields display when no login is required:

- **Account Name (If required).** Enter the account name provided by your ISP. This might also be called the host name.
- **Domain Name (If required).** Enter the domain name provided by your ISP.

These fields display when your ISP requires a login:
• **Internet Service Provider Encapsulation.** ISP types. The choices are PPPoE, PPTP, or L2TP.

• **Login.** The login name provided by your ISP. This is often an email address.

• **Password.** The password that you use to log in to your ISP.

• **Idle Timeout (In minutes).** If you want to change the login timeout, enter a new value in minutes. This determines how long the router keeps the Internet connection active after there is no Internet activity from the LAN. Entering a value of 0 (zero) means never log out.

**Internet IP Address.**

• **Get Dynamically from ISP.** Your ISP uses DHCP to assign your IP address. Your ISP automatically assigns these addresses.

• **Use Static IP Address.** Enter the IP address, IP subnet mask, and the gateway IP address that your ISP assigned. The gateway is the ISP’s router to which your router will connect.

**Domain Name Server (DNS) Address.** The DNS server is used to look up site addresses based on their names.

• **Get Automatically from ISP.** Your ISP uses DHCP to assign your DNS servers. Your ISP automatically assigns this address.

• **Use These DNS Servers.** If you know that your ISP does not automatically transmit DNS addresses to the router during login, select this option, and enter the IP address of your ISP’s primary DNS server. If a secondary DNS server address is available, enter it also.

**Router MAC Address.** The Ethernet MAC address used by the router on the Internet port. Some ISPs register the MAC address of the network interface card in your computer when your account is first opened. They will then accept traffic only from the MAC address of that computer. This feature allows your router to use your computer’s MAC address (this is also called cloning).

• **Use Default Address.** Use the default MAC address.

• **Use Computer MAC Address.** The router will capture and use the MAC address of the computer that you are now using. You have to use the one computer that is allowed by the ISP.

• **Use This MAC Address.** Enter the MAC address that you want to use.
Attached Devices

You can view all computers or devices that are currently connected to your network here. From the Basic Home screen, select **Attached Devices** to display the following screen:

Wired devices are connected to the router with Ethernet cables. Wireless devices have joined the wireless network.

- **# (number)**. The order in which the device joined the network.
- **IP Address**. The IP address that the router assigned to this device when it joined the network. Note that this number can change if a device is disconnected and rejoins the network.
- **MAC Address**. The unique MAC address for each device does not change. The MAC address is typically shown on the product label.
- **Device Name**. If the device name is known, it is shown here.

You can click **Refresh** to update this screen.
Parental Controls

The first time you select Parental Controls from the Basic Home screen, you are automatically directed to the Internet, where you can learn more about Live Parental Controls or download the application. The following screen displays:

ReadySHARE USB Storage

You can view information about a USB storage device that is connected to the router’s USB port here. From the Basic Home screen, select ReadySHARE to display the USB Storage (Basic Settings) screen:
This screen displays the following:

- **Network/Device Name.** The default is \readyshare. This is the name used to access the USB device connected to the router.
- **Available Network Folders.** The folders on the USB device.

**Share Name.** If only one device is connected, the default share name is USB_Storage. You can click the name shown or you can type it in the address field of your Web browser. If Not Shared is shown, the default share has been deleted and no other share for the root folder exists. Click the link to change this setting.

**Read/Write Access.** Shows the permissions and access controls on the network folder: All – no password (the default) allows all users to access the network folder. The user name (account name) for All – no password is guest. The password for admin is the same one that you use to log in to the router. By default, it is password.

**Folder Name.** Full path used by the network folder.

**Volume Name.** Volume name from the storage device (either USB drive or HDD).

**Total/Free Space.** Shows the current utilization of the storage device.

- **Edit.** Click the Edit button to edit the Available Network Folders settings.
- **Safely Remove a USB Device.** Click to safely remove the USB device attached to your router.

You can click **Refresh** to update this screen.

For more information about USB storage, see **Chapter 5, USB Storage.**

---

**Basic Wireless Settings**

The Wireless Settings screen lets you view or configure the wireless network setup.

The WNDRMAC router comes with preset security. This means that the Wi-Fi network name (SSID), network key (password), and security option (encryption protocol) are preset in the factory. You can find the preset SSID and password on the bottom of the unit.

---

**Note:** The preset SSID and password are uniquely generated for every device to protect and maximize your wireless security.

---

**To view or change basic wireless settings:**

**NETGEAR recommends that you do not change your preset security settings.** If you do decide to change your preset security settings, make a note of the new settings and store it in a safe place where you can easily find it.
If you use a wireless computer to change the wireless network name (SSID) or other wireless security settings, you are disconnected when you click Apply. To avoid this problem, use a computer with a wired connection to access the router.

1. On the Basic Home screen, select **Wireless** to display the Wireless Settings screen.

![](image)

You can scroll down to view more settings. The screen sections, settings, and procedures are explained in the following sections.

2. Make any changes that are needed, and click **Apply** to save your settings.

3. Set up and test your wireless devices and computers to make sure that they can connect wirelessly. If they do not, check the following:
   - Is your wireless device or computer connected to your network or another wireless network in your area? Some wireless devices automatically connect to the first open network (without wireless security) that they discover.
   - Does your wireless device or computer show up on the Attached Devices screen? If it does, then it is connected to the network.
   - If you are not sure what the network name (SSID) or password is, look on the label on the bottom of your router.

**Wireless Settings Screen Fields**

**Region Selection**

The location where the router is used. Select from the countries in the list. Note that in the United States, the region is fixed to United States and is not interchangeable.

**Wireless Network**

*2.4 GHz b/g/n and 5.0 GHz a/n*

The b/g/n and a/n notation references the 802.11 standards of conformance. For example, 2.4 b/g/n conforms to 802.11b, 802.11g, and 802.11n at 2.4 GHz radio frequency.
Enable SSID Broadcast. This setting allows the router to broadcast its SSID so wireless stations can see this wireless name (SSID) in their scanned network lists. This check box is selected by default. To turn off the SSID broadcast, clear the Allow Broadcast of Name (SSID) check box and click Apply.

Enable Wireless Isolation. If this check box is selected, then wireless clients (computers or wireless devices) that join the network can use the Internet, but cannot access each other or access Ethernet devices on the network.

Name (SSID). The SSID is also known as the wireless network name. Enter a 32-character (maximum) name in this field. This field is case-sensitive. The default SSID is randomly generated, and NETGEAR strongly recommends that you do not change this.

Channel. This setting is the wireless channel used by the gateway. Enter a value from 1 through 13. (For products in the North America market, only channels 1 through 11 can be operated.) Do not change the channel unless you experience interference (shown by lost connections or slow data transfers). If this happens, experiment with different channels to see which is the best.

Mode. Up to 130 Mbps is the default and allows 802.11n and 802.11g wireless devices to join the network. g & b supports up to 54 Mbps. The 300 Mbps setting allows 802.11n devices to connect at this speed.

Security Options Settings
The Security Options section of the Wireless Settings screen lets you change the security option and passphrase. Please note that NETGEAR recommends that you not change the security option or passphrase, but if you want to change these settings, this section explains how. Do not disable security.

Change WPA Security Option and Passphrase
1. Under Security Options, select the WPA option you want.

2. In the Passphrase field that displays when you select a WPA security option, enter the network key (passphrase) that you want to use. It is a text string from 8 to 63 characters.
Guest Networks

Adding a guest network allows visitors at your home to use the Internet without giving them your wireless security key. You can add a guest network to each wireless network: 2.4 GHz b/g/n and 5.0 GHz a/n.

To set up a 2.4 GHz b/g/n guest network:

1. Select Basic > Guest Network to display the following screen:

2. Select any of the following wireless settings:
   
   **Enable Guest Network.** When this check box is selected, the guest network is enabled, and guests can connect to your network using the SSID of this profile.

   **Enable SSID Broadcast.** If this check box is selected, the wireless access point broadcasts its name (SSID) to all wireless stations. Stations with no SSID can adopt the correct SSID for connections to this access point.

   **Allow guest to access My Local Network.** If this check box is selected, any user who connects to this SSID can access local networks associated with the router like users in the primary SSID.

   **Enable Wireless Isolation.** If this check box is selected, then wireless clients (computers or wireless devices) that join the network can use the Internet, but cannot access each other or access Ethernet devices on the network.

3. Give the guest network a name.

   The guest network name is case-sensitive and can be up to 32 characters. You then manually configure the wireless devices in your network to use the guest network name in addition to the main non-guest SSID.

4. Select a security option from the list. The security options are described in Guest Network Wireless Security Options on page 28.

5. Click Apply to save your selections.
To set up a 5.0 GHz a/n guest network:

1. Select **Basic > Guest Network** and scroll down to the Wireless Settings (5 GHz) section to display the following screen:

2. Select any of the following wireless settings:

   **Enable Guest Network.** When this check box is selected, the guest network is enabled, and guests can connect to your network using the SSID of this profile.

   **Enable SSID Broadcast.** If this check box is selected, the wireless access point broadcasts its name (SSID) to all wireless stations. Stations with no SSID can adopt the correct SSID for connections to this access point.

   **Allow guest to access My Local Network.** If this check box is selected, any user who connects to this SSID can access local networks associated with the router like users in the primary SSID.

   **Enable Wireless Isolation.** If this check box is selected, then wireless clients (computers or wireless devices) that join the network can use the Internet, but cannot access each other or access Ethernet devices on the network.

3. Enter a name for the guest network.

4. Select a security option from the list. The security options are described in the following section.

5. Click **Apply** to save your selections.

**Guest Network Wireless Security Options**

A security option is the type of security protocol applied to your wireless network. The security protocol in force encrypts data transmissions and ensures that only trusted devices receive authorization to connect to your network. Wi-Fi Protected Access (WPA) has several options including pre-shared key (PSK) encryption and 802.1x encryption for enterprises.
This section presents an overview of the security options and provides guidance on when to use which option. Note that it is also possible to set up a guest network without wireless security. NETGEAR does not recommend this.

**WEP Encryption**

WEP uses an old encryption method and can be easily decoded with today’s powerful computers. Use this mode only when you have a very old legacy wireless client that does not support WPA-PSK. The Wi-Fi alliance highly recommends against using WEP and plans to make it obsolete.

**WPA Encryption**

WPA encryption is built into all hardware that has the Wi-Fi-certified seal. This seal means the product is authorized by the Wi-Fi Alliance ([http://www.wi-fi.org/](http://www.wi-fi.org/)) because it complies with the worldwide single standard for high-speed wireless local area networking.

WPA-PSK uses a much stronger encryption algorithm than WEP so it is harder to decode. This option uses a passphrase to perform the authentication and generate the initial data encryption keys. Then it dynamically varies the encryption key. WPA-PSK uses Temporal Key Integrity Protocol (TKIP) data encryption, implements most of the IEEE 802.11i standard, and is designed to work with all wireless network interface cards, but not all wireless access points. It is superseded by WPA2-PSK.

WPA2-PSK is the strongest. It is advertised to be theoretically indecipherable due to the greater degree of randomness in encryption keys that it generates. WPA2-PSK gets higher speed because it is usually implemented through hardware, while WPA-PSK is usually implemented through software. WPA2-PSK uses a passphrase to authenticate and generate the initial data encryption keys. Then it dynamically varies the encryption key.

WPS-PSK + WPA2-PSK Mixed Mode can provide broader support for all wireless clients. WPA2-PSK clients get higher speed and security, and WPA-PSK clients get decent speed and security. The product documentation for your wireless adapter and WPA client software should have instructions about configuring their WPA settings.

WPA-802.1x is enterprise-level security and requires an authentication server to recognize and authorize client access. The authentication server is called Remote Authentication Dial In User Service (RADIUS). Every wireless client has a user login on the RADIUS server, and the router has a client login on the RADIUS server. Data transmissions are encrypted with an automatically generated key.
Genie Advanced Home

Specifying custom settings

This chapter explains the features available from the Genie Advanced Home screen, shown in the following figure:

This screen is also displayed through the Administration menu.

This chapter contains the following sections:

- *Setup Wizard*
- *WPS Wizard*
- *Setup Menu*
- *WAN Setup*
- *LAN Setup*
- *Quality of Service (QoS) Setup*

Some selections on the Advanced Home screen are described in separate chapters:

- *USB Storage*. See *Chapter 5, USB Storage*
- *Security*. See *Chapter 6, Security*
- *Administration*. See *Chapter 7, Administration*.
- *Advanced Setup*. See *Chapter 8, Advanced Settings*
**Setup Wizard**

The NETGEAR Genie installation process is launched the first time you set up the router. After setting up the router the first time, if you want to perform this task again, you can run Setup Wizard from the Advanced tab of the Genie.

1. Select **Setup Wizard** to display the following screen:

   ![Setup Wizard Screen](image)

2. Select either **Yes** or **No, I want to configure the router myself**. If you select No, you are taken to the Internet Setup screen (see *Internet Setup* on page 20).

3. If you selected Yes, click **Next**. The following screen displays:

   ![Connection Detection Screen](image)

The Setup Wizard searches your Internet connection for servers and protocols to determine your ISP configuration. The following screen displays:

![Configuration Screen](image)

---

Genie Advanced Home

31
WPS Wizard

The WPS Wizard helps you add a WPS-capable client device (a wireless device or computer) to your network. On the client device you need to either press its WPS button or locate its WPS PIN.

To use the WPS Wizard:

1. Select Advanced > WPS Wizard.
2. Click Next. The following screen lets you select the method for adding the WPS client (a wireless device or computer).

![WPS Wizard Screen]

You can use either the push button or PIN method.

3. Select either Push Button or PIN Number.
   - To use the push button method, either click the WPS button on this screen, or press the WPS button located on the side of the router. Within two minutes, go to the wireless client and press its WPS button to join the network without entering a password.
   - To use the PIN method, select the PIN Number radio button, enter the client security PIN, and click Next.
Within two minutes, go to the client device and use its WPS software to join the network without entering a password.

The router attempts to add the WPS-capable device. The WPS LED on the front of the router blinks green. When the router establishes a WPS connection, the LED is solid green and the router WPS screen displays a confirmation message.

4. Repeat Step 2 and Step 3 to add another WPS client to your network.

Setup Menu

Select Advanced > Setup to display the Setup menu. The following selections are available:

- **Internet Setup.** This is a shortcut to the same Internet Setup screen that you can access from the dashboard on the Basic Home screen. See Internet Setup on page 20.
- **Wireless Setup.** This is a shortcut to the same Wireless Settings screen that you can access from the dashboard on the Basic Home screen. See Basic Wireless Settings on page 24.
- **Guest Network.** This is a shortcut to the same Guest Network screen that you can access from the dashboard on the Basic Home screen. See Guest Networks on page 27.
- **WAN Setup.** Internet (WAN) setup. See WAN Setup on page 34.
- **LAN Setup.** Local area network (LAN) setup. See LAN Setup on page 37.
- **QoS Setup.** Quality of Service (QoS) setup. See Quality of Service (QoS) Setup on page 40.
WAN Setup

The WAN Setup screen lets you configure a DMZ (demilitarized zone) server, change the Maximum Transmit Unit (MTU) size, and enable the router to respond to a ping on the WAN (Internet) port. Select Advanced > Setup > WAN Setup to view the following screen:

- **Disable Port Scan and DoS Protection.** DoS protection protects your LAN against Denial of Service attacks such as Syn flood, Smurf Attack, Ping of Death, Teardrop Attack, UDP Flood, ARP Attack, Spoofing ICMP, Null Scan, and many others. This should be disabled only in special circumstances.

- **Default DMZ Server.** This feature is sometimes helpful when you are playing online games and/or videoconferencing. Be careful when using this feature because it makes the firewall security less effective. See the following section, Default DMZ Server for more details.

- **Respond to Ping on Internet Port.** If you want the router to respond to a ping from the Internet, select this check box. Use this only as a diagnostic tool because it allows your router to be discovered. Do not select this check box unless you have a specific reason.

- **Disable IGMP Proxying.** IGMP proxying allows a computer on the local area network (LAN) to receive the multicast traffic it is interested in from the Internet. You can select this check box to disable the feature if you do not need it.

- **MTU Size (in bytes).** The normal MTU (Maximum Transmit Unit) value for most Ethernet networks is 1500 bytes, or 1492 bytes for PPPoE connections. For some ISPs you might need to reduce the MTU. This is rarely required, and should not be done unless you are sure it is necessary for your ISP connection. See Change the MTU Size on page 35.

- **NAT Filtering.** Network Address Translation (NAT) determines how the router processes inbound traffic. Secured NAT provides a secured firewall to protect the computers on the LAN from attacks from the Internet, but might prevent some Internet games, point-to-point applications, or multimedia applications from functioning. Open NAT provides a much less secured firewall, but allows almost all Internet applications to function.
Default DMZ Server

The default DMZ server feature is helpful when you are using some online games and videoconferencing applications that are incompatible with Network Address Translation (NAT). The router is programmed to recognize some of these applications and to work correctly with them, but there are other applications that might not function well. In some cases, one local computer can run the application correctly if that computer’s IP address is entered as the default DMZ server.

WARNING!

DMZ servers pose a security risk. A computer designated as the default DMZ server loses much of the protection of the firewall and is exposed to exploits from the Internet. If compromised, the DMZ server computer can be used to attack other computers on your network.

Incoming traffic from the Internet is usually discarded by the router unless the traffic is a response to one of your local computers or a service that you have configured in the Port Forwarding/Port Triggering screen. Instead of discarding this traffic, you can have it forwarded to one computer on your network. This computer is called the default DMZ server.

To set up a default DMZ server, do the following:

1. On the WAN Setup screen, select the Default DMZ Server check box.
2. Type the IP address.
3. Click Apply.

Change the MTU Size

The Maximum Transmission Unit (MTU) is the largest data packet a network device transmits. When one network device communicates across the Internet with another, the data packets travel through many devices along the way. If any device in the data path has a lower MTU setting than the other devices, the data packets has to be split or “fragmented” to accommodate the one with the smallest MTU.

The best MTU setting for NETGEAR equipment is often just the default value, and changing the value might fix one problem but cause another. Leave MTU unchanged unless one of these situations occurs:

- You have problems connecting to your ISP or other Internet service, and the technical support of either the ISP or NETGEAR recommends changing the MTU setting. These web-based applications might require an MTU change:
  - A secure website that won’t open, or displays only part of a Web page
  - Yahoo email
  - MSN portal
- America Online’s DSL service
- You use VPN and have severe performance problems.
- You used a program to optimize MTU for performance reasons, and now you have connectivity or performance problems.

**Note:** An incorrect MTU setting can cause Internet communication problems such as the inability to access certain Web sites, frames within Web sites, secure login pages, or FTP or POP servers.

If you suspect an MTU problem, a common solution is to change the MTU to 1400. If you are willing to experiment, you can gradually reduce the MTU from the maximum value of 1500 until the problem goes away. The following table describes common MTU sizes and applications.

**Table 2. Common MTU Sizes**

<table>
<thead>
<tr>
<th>MTU</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>1500</td>
<td>The largest Ethernet packet size and the default value. This is the typical setting for non-PPPoE, non-VPN connections, and is the default value for NETGEAR routers, adapters, and switches.</td>
</tr>
<tr>
<td>1492</td>
<td>Used in PPPoE environments.</td>
</tr>
<tr>
<td>1472</td>
<td>Maximum size to use for pinging. (Larger packets are fragmented.)</td>
</tr>
<tr>
<td>1468</td>
<td>Used in some DHCP environments.</td>
</tr>
<tr>
<td>1460</td>
<td>Usable by AOL if you do not have large email attachments, for example.</td>
</tr>
<tr>
<td>1436</td>
<td>Used in PPTP environments or with VPN.</td>
</tr>
<tr>
<td>1400</td>
<td>Maximum size for AOL DSL.</td>
</tr>
<tr>
<td>576</td>
<td>Typical value to connect to dial-up ISPs.</td>
</tr>
</tbody>
</table>

**To change the MTU size:**

1. Select **Advanced > Setup > WAN Setup**.
2. In the MTU Size field, enter a new size between 64 and 1500.
3. Click **Apply** to save the settings.
LAN Setup

The LAN Setup screen allows configuration of LAN IP services such as Dynamic Host Configuration Protocol (DHCP) and Routing Information Protocol (RIP).

The router is shipped preconfigured to use private IP addresses on the LAN side and to act as a DHCP server. The router’s default LAN IP configuration is:

- LAN IP address: 192.168.1.1
- Subnet mask: 255.255.255.0

These addresses are part of the designated private address range for use in private networks and should be suitable for most applications. If your network has a requirement to use a different IP addressing scheme, you can make those changes in the LAN Setup screen.

To change the LAN settings:

Note: If you change the LAN IP address of the router while connected through the browser, you will be disconnected. You will have to open a new connection to the new IP address and log in again.

1. Select Advanced > Setup > LAN Setup to display the following screen:

2. Enter the settings that you want to customize. These settings are described in the following section, LAN Setup Screen Settings.

3. Click Apply to save your changes.
LAN Setup Screen Settings

**LAN TCP/IP Setup**

- **IP Address.** The LAN IP address of the router.
- **IP Subnet Mask.** The LAN subnet mask of the router. Combined with the IP address, the IP subnet mask allows a device to know which other addresses are local to it, and which have to be reached through a gateway or router.
- **RIP Direction.** Router Information Protocol (RIP) allows a router to exchange routing information with other routers. This setting controls how the router sends and receives RIP packets. Both is the default setting. With the Both or Out Only setting, the router broadcasts its routing table periodically. With the Both or In Only setting, the router incorporates the RIP information that it receives.
- **RIP Version.** This controls the format and the broadcasting method of the RIP packets that the router sends. It recognizes both formats when receiving. By default, the RIP function is disabled.

  - **RIP-1** is universally supported. It is adequate for most networks, unless you have an unusual network setup.

**Use Router as a DHCP Server**

This check box is usually selected so that the router functions as a Dynamic Host Configuration Protocol (DHCP) server.

- **Starting IP Address.** Specify the start of the range for the pool of IP addresses in the same subnet as the router.
- **Ending IP Address.** Specify the end of the range for the pool of IP addresses in the same subnet as the router.

**Address Reservation**

When you specify a reserved IP address for a computer on the LAN, that computer receives the same IP address each time it accesses the router’s DHCP server. Assign reserved IP addresses to servers that require permanent IP settings.

**Use the Router as a DHCP Server**

By default, the router functions as a DHCP server, allowing it to assign IP, DNS server, and default gateway addresses to all computers connected to the router’s LAN. The assigned default gateway address is the LAN address of the router. The router assigns IP addresses to the attached computers from a pool of addresses specified in this screen. Each pool address is tested before it is assigned to avoid duplicate addresses on the LAN. For most applications, the default DHCP and TCP/IP settings of the router are satisfactory.
You can specify the pool of IP addresses to be assigned by setting the starting IP address and ending IP address. These addresses should be part of the same IP address subnet as the router’s LAN IP address. Using the default addressing scheme, you should define a range between 192.168.1.2 and 192.168.1.254, although you might want to save part of the range for devices with fixed addresses.

The router delivers the following parameters to any LAN device that requests DHCP:

- An IP address from the range you have defined
- Subnet mask
- Gateway IP address (the router’s LAN IP address)
- Primary DNS server (if you entered a primary DNS address in the Internet Setup screen; otherwise, the router’s LAN IP address)
- Secondary DNS server (if you entered a secondary DNS address in the Internet Setup screen)

To use another device on your network as the DHCP server, or to manually configure the network settings of all of your computers, clear the Use Router as DHCP Server check box and click Apply. Otherwise, leave this check box selected. If this service is not enabled and no other DHCP server is available on your network, you need to set your computers’ IP addresses manually or they will not be able to access the router.

Address Reservation

When you specify a reserved IP address for a computer on the LAN, that computer always receives the same IP address each time it accesses the router’s DHCP server. Reserved IP addresses should be assigned to computers or servers that require permanent IP settings.

To reserve an IP address:

1. In the Address Reservation section of the screen, click the Add button.
2. In the IP Address field, type the IP address to assign to the computer or server. (Choose an IP address from the router’s LAN subnet, such as 192.168.1.x.)
3. Type the MAC address of the computer or server.
   
   Tip: If the computer is already on your network, you can copy its MAC address from the Attached Devices screen and paste it here.

4. Click Apply to enter the reserved address into the table.
   
   The reserved address is not assigned until the next time the computer contacts the router’s DHCP server. Reboot the computer or access its IP configuration and force a DHCP release and renew.

To edit or delete a reserved address entry, select the radio button next to the reserved address you want to edit or delete. Then click Edit or Delete.
Quality of Service (QoS) Setup

QoS is an advanced feature that can be used to prioritize some types of traffic ahead of others. The WNDRMAC router can provide QoS prioritization over the wireless link and on the Internet connection. To configure QoS, use the QoS Setup screen.

Select Advanced > Setup > QoS Setup to display the following screen:

Enable WMM QoS for Wireless Multimedia Applications

The WNDRMAC router supports Wi-Fi Multimedia Quality of Service (WMM QoS) to prioritize wireless voice and video traffic over the wireless link. WMM QoS provides prioritization of wireless data packets from different applications based on four access categories: voice, video, best effort, and background. For an application to receive the benefits of WMM QoS, both it and the client running that application have to have WMM enabled. Legacy applications that do not support WMM, and applications that do not require QoS, are assigned to the best effort category, which receives a lower priority than voice and video.

WMM QoS is enabled by default. You can disable it in the QoS Setup screen by clearing the Enable WMM check box and clicking Apply.

Set Up QoS for Internet Access

You can give prioritized Internet access to the following types of traffic:

- Specific applications
- Specific online games
- Individual Ethernet LAN ports of the router
- A specific device by MAC address

To specify prioritization of traffic, you have to create a policy for the type of traffic and add the policy to the QoS Policy table in the QoS Setup screen. For convenience, the QoS Policy table lists many common applications and online games that can benefit from QoS handling.
QoS for Applications and Online Gaming

To create a QoS policy for applications and online games:

1. In the QoS Setup screen, select the Turn Internet Access QoS On checkbox.
2. Click the Setup QoS Rule button to see the existing priority rules. On this screen you can edit or delete a rule by selecting its radio button and clicking either the Edit or Delete button. You can also delete all of the rules by simply clicking the Delete All button.

3. To add a priority rule, click Add Priority Rule to display the following screen:

4. In the QoS Policy for field, type the name of the application or game.
5. In the Priority Category list, select either Applications or Online Gaming. In either case, a list of applications or games displays in the list.
6. You can select an existing item from the list, or you can scroll and select Add a New Application or Add a New Game, as applicable.
a. If you add a new entry, the Priority Rules screen expands as shown:

![Priority Rules Screen](image)

b. In the QoS Policy for field, enter a descriptive name for the new application or game.

c. In the Connection Type field, select either TCP, UDP, or both (TCP/UDP), and specify the port number or range of port numbers used by the application or game.

7. From the Priority list, select the priority that this traffic should receive relative to other applications and traffic when accessing the Internet. The options are Low, Normal, High, and Highest.

8. Click Apply to save this rule to the QoS Policy list and return to the QoS Setup screen.

**QoS for a Router LAN Port**

To create a QoS policy for a device connected to one of the router’s LAN ports:


2. Click the Setup QoS Rule button.

3. Click the Add Priority Rule button.
4. From the Priority Category list, select **Ethernet LAN Port**, as shown in the following figure:

![QoS Setup Screen](image)

5. From the Ethernet LAN port list, select the LAN port that will have a QoS policy.
6. From the Priority list, select the priority that this port’s traffic should receive relative to other applications and traffic when accessing the Internet. The options are Low, Normal, High, and Highest.
7. Click **Apply** to save this rule to the QoS Policy list and return to the QoS Setup screen.
8. In the QoS Setup screen, click **Apply**.

**QoS for a MAC Address**

To create a QoS policy for traffic from a specific MAC address:

2. Click **Add Priority Rule**.
3. From the Priority Category list, select MAC Address to display the following screen:

4. If the device to be prioritized appears in the MAC Device List, select its radio button. The information from the MAC Device List populates the policy name, MAC Address, and Device Name fields. If the device does not appear in the MAC Device List, click Refresh. If it still does not appear, you have to complete these fields manually.

5. From the Priority list, select the priority that this device’s traffic should receive relative to other applications and traffic when accessing the Internet. The options are Low, Normal, High, and Highest.

6. Click Apply to save this rule to the QoS Policy list and return to the QoS Setup screen.

7. In the QoS Setup screen, select the Turn Internet Access QoS On check box.

8. Click Apply.

**Editing or Deleting an Existing QoS Policy**

To edit or delete a QoS policy:

1. Select Advanced > QoS Setup to display the QoS Setup screen.

2. Select the radio button next to the QoS policy to be edited or deleted, and do one of the following:
   - Click Delete to remove the QoS policy.
   - Click Edit to edit the QoS policy. Follow the instructions in the preceding sections to change the policy settings.

3. Click Apply in the QoS Setup screen to save your changes.
This chapter describes how to access and configure a USB storage drive attached to your router. Be aware that the USB port on the router can be used only to connect USB storage devices like flash drives or hard drives. Do not connect computers, USB modems, CD drives, or DVD drives to the router USB port.

This chapter contains the following sections:

- *USB Drive Requirements*
- *ReadySHARE Access*
- *File Sharing Scenarios*
- *Basic Settings*
- *USB Storage Advanced Settings*
- *Safely Remove a USB Drive*
- *Media Server Settings*
- *Specify Approved USB Devices*
- *Connect to the USB Drive from a Remote Computer*

For additional information about ReadySHARE features, see [www.netgear.com/readyshare](http://www.netgear.com/readyshare).
USB Drive Requirements

The router works with 1.0 and 1.1 (USB Full Speed) and 2.0 (USB High Speed) standards. The approximate USB bus speeds are shown in the following table. Actual bus speeds can vary, depending on the CPU speed, memory, speed of the network, and other variables.

Table 3. USB Drive Speeds

<table>
<thead>
<tr>
<th>Bus</th>
<th>Speed/Sec</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB 1.1</td>
<td>12 Mbits</td>
</tr>
<tr>
<td>USB 2.0</td>
<td>480 Mbits</td>
</tr>
</tbody>
</table>

The router should work with most USB-compliant external flash and hard drives. For the most up-to-date list of USB drives supported by the router, go to:

http://kbserver.netgear.com/readyshare

The router supports both read and write for FAT16, FAT32, NTFS, and Linux file systems (EXT2 and EXT3).

Note: Some USB external hard drives and flash drives require drivers to be loaded in to the PC before the PC can access the USB device. Such USB devices will not work with the router.

ReadySHARE Access

Once you have set up your router, you can connect any USB storage device and share the contents with other users on your network.

You can access your USB device in any of the following ways:

- On Windows 7, Windows XP, Windows Vista, and Windows 2000 systems, select Start > Run and enter \readyshare in the dialog box. Click OK.
- On Windows 7, Windows XP, Windows Vista, and Windows 2000 systems, open Internet Explorer or Safari, and enter \readyshare in the address bar.
- On Mac OS X (version 10.2 or later), enter smb://readyshare in the address bar.
- In My Network Places, enter \readyshare in the address bar.

File Sharing Scenarios

You can share files on the USB drive for a wide variety of business and recreational purposes. The files can be any PC, Mac, or Linux file type including text files, Word, PowerPoint, Excel, MP3, pictures, and multimedia. USB drive applications include:
• Sharing multimedia with friends and family such as MP3 files, pictures, and other multimedia with local and remote users.
• Sharing resources on your network. You might want to store files in a central location so that you do not have to power up a computer to perform local sharing. In addition, you can share files between Macintosh, Linux, and PC computers by using the USB drive as a go-between across the systems.
• Sharing files such as Word documents, PowerPoint presentations, and text files with remote users.

A few common uses are described in the following sections.

Sharing Photos

You can create your own central storage location for photos and multimedia. This eliminates the need to log in to (and pay for) an external photo sharing site.

To share files with your friends and family:

1. Insert your USB drive into the USB port on the router either directly or with a USB cable.
   Computers on your local area network (LAN) can automatically access this USB drive using a Web browser or Microsoft Networking.
2. If you want to specify read-only access or to allow access from the Internet, see USB Storage Advanced Settings on page 51.

Storing Files in a Central Location for Printing

This scenario is for a family that has one high-quality color printer directly attached to a computer, but not shared on the local area network (LAN). This family does not have a print server.

• One family member has photos on a Macintosh computer that she wants to print.
• The photo-capable color printer is directly attached to a PC, but not shared on the network.
• The Mac and PC are not visible to each other on the network.

To print photos from a Mac on the printer attached to a PC:

1. On the Mac, access the USB drive by typing \readyshare in the address field of a Web browser. Then copy the photos to the USB drive.
2. On the PC, use a Web browser or Microsoft Networking to copy the files from the USB drive to the PC. Then print the files.

Sharing Large Files over the Internet

Sending files that are larger than 5 MB can pose a problem for many email systems. The router allows you to share very large files such as PowerPoint presentations or .zip files over the Internet. FTP can be used to easily download shared files from the router.
Sharing files with a remote colleague involves the following considerations:

- There are two user accounts: admin and guest. The password for admin is the same one that you use to access the router. By default, it is **password**. The guest user account has no password.
- On the FTP site, the person receiving the files should use the guest user account and enter any password (FTP requires that you type something in the password field).
- Be sure to select the **FTP (via Internet)** check box in the USB Storage Advanced Settings screen. This option supports both downloading and uploading of files.

**Note:** You can enable the HTTP (via Internet) option on the Advanced USB Storage screen to share large files. This option supports downloading files only.

### Basic Settings

You can view or edit basic settings for the USB storage device attached to your router.

You can access this feature through **Basic > ReadySHARE**, or through **Advanced > USB Storage > Basic Settings**.

The USB Storage (Basic Settings) screen displays:

![Basic Settings Screenshot](image)

By default, the USB storage device is available to all computers on your local area network (LAN).
To access your USB device:

1. Click the network device name or the share name.

2. With Finder active, from the Go menu, select **Connect to Server** (or, with the Finder active, press **Command-k**).

3. For SMB://readyshare, click **Connect**.
Finder shows the drive.

**Note:** If you logged in to the router before you connected your USB device, you might not see your USB device in the router screens until you log out and then log back in again.

### Add or Edit a Network Folder

1. You can access this feature by selecting **Basic > ReadySHARE > Edit**, or **Advanced > USB Storage > Advanced Settings**. Scroll down to the bottom of the screen to view the Available Network Folder section as shown:

2. Specify the changes that you want to make:
• To add a folder, click **Create Network Folder**.

  ![Create Network Folder](http://www.routerlogin.net/USB_Folder_creat.htm)

• To edit a folder, select its radio button and then click **Edit**.

3. You can use this screen to select a folder, to change the share name, or to change the read Access or write access from **All – no password** to **admin**.

   The user name (account name) for All – no password is guest. The password for admin is the same one that is used to log in to the router. By default, it is password.

4. Click **Apply** for your changes to take effect.

### USB Storage Advanced Settings

You can set up the device name, workgroups, and network folders for your USB device. On the Advanced tab, select **USB Storage > Advanced Settings** to display the following screen:

![Advanced Settings](http://www.routerlogin.net/USB_AdvSettings.htm)

You can use this screen to specify access to the USB storage device.
• **Network Device Name.** The default is readyshare. This is the name used to access the USB device connected to the router.

• **Workgroup.** If you are using a Windows workgroup rather than a domain, the workgroup name is displayed here. The name works only in an operating system that supports NetBIOS, such as Microsoft Windows.

• **Access Method.** The access methods are described here.

  **Network Connection.** Enabled by default, this connection allows all users on the LAN to have access to the USB drive.

  **HTTP.** Enabled by default. You can type `http://readyshare.routerlogin.net/shares` to access the USB drive.

  **HTTP (via internet).** Disabled by default. If you enable this setting, remote users can type `http://public IP address/shares` (for example, `http://1.1.10.102/shares`) or a URL domain name to access the USB drive over the Internet. This setting supports file uploading only.

  **FTP.** Disabled by default.

  **FTP (via internet).** Disabled by default. If you enable this setting, remote users can access the USB drive through FTP over the Internet. This setting supports both downloading and uploading of files.

**Available Network Folders**

You need to scroll down to view this section of the screen:

• **Share Name.** If only 1 device is connected, the default share name is USB_Storage. You can click the name shown or you can type it in the address field of your Web Browser. If Not Shared is shown, the default share has been deleted and no other share for the root folder exists. Click the link to change this setting.
**Read/Write Access.** Shows the permissions and access controls on the network folder: All - no password (the default) allows all users to access the network folder. The password for admin is the same one that you use to log in to the router.

**Folder Name.** Full path used by the network folder.

**Volume Name.** Volume name from the storage device (either USB drive or HDD).

**Total/Free Space.** Shows the current utilization of the storage device.

---

**Safely Remove a USB Drive**

To safely remove a USB disk drive so that no users can access it, select **USB Storage > Basic Settings** and click the **Safely Remove USB Device** button. This takes the drive offline.

---

**Media Server Settings**

By default, the router is set up to act as a Ready DLNA media server, which lets you view movies and photos on DLNA/UPnP AV compliant media players, such as Xbox360, Playstation, and NETGEAR’s Digital Entertainer Live.

To view these settings, select **Advanced > USB Storage > Media Server** to display the following screen:

![Media Server Settings Screen](image)

By default the Enable Media Server check box and the Automatic (when new files are added) radio button are selected. When these options are selected, the router scans for media files whenever new files are added to the ReadyShare USB hard drive.
Specify Approved USB Devices

For more security, you can set up the router to share approved USB devices only.

1. Select Advanced > Advanced Setup and click the Approved Devices button. The USB Drive Approved Devices screen displays:

2. Select the USB device from the Available USB Devices list.
3. Click Add.
4. Select the Allow only approved devices check box.
5. Click Apply so that your change takes effect.

If you want to approve another USB device, you have to first click the Safely Remove USB Device button for the currently connected USB device. Connect the other USB device, and repeat this process.

Connect to the USB Drive from a Remote Computer

To connect to the USB drive from remote computers with a Web browser, you have to use the router’s Internet port IP address. If you are using Dynamic DNS, you can type the DNS name, rather than the IP address. You can view the router’s Internet IP address from the dashboard on the Basic Home screen or the Advanced Home screen.
Access the Router’s USB Drive Remotely Using FTP

To connect to the router’s USB drive using a Web browser:

1. Connect to the router by typing `ftp://` and the Internet port IP address in the address field of Internet Explorer or Netscape Navigator. For example, `ftp://10.1.65.4`
   
   If you are using Dynamic DNS, you can type the DNS name, rather than the IP address.

2. Type the account name and password that has access rights to the USB drive. The user name (account name) for All – no password is `guest`.

3. The directories of the USB drive that your account has access to are displayed, for example, `share/partition1/directory1`. You can now read and copy files from the USB directory.
Security

Keeping unwanted content out of your network

This chapter explains how to use the basic firewall features of the router to prevent objectionable content from reaching the PCs and other devices connected to your network.

This chapter includes the following sections:

• **Keyword Blocking of HTTP Traffic**
• **Block Services (Port Filtering)**
• **Schedule Blocking**
• **Security Event Email Notifications**
Keyword Blocking of HTTP Traffic

Use keyword blocking to prevent certain types of HTTP traffic from accessing your network. The blocking can be always or according to a schedule.

1. Select Advanced > Security > Block Sites to display the following screen:

   ![Keyword Blocking Screen]

2. Select one of the keyword blocking options:
   - **Per Schedule.** Turn on keyword blocking according to the Schedule screen settings.
   - **Always.** Turn on keyword blocking all the time, independent of the Schedule screen.

3. In the Keyword field, enter a keyword or domain, click **Add Keyword**, and click **Apply**.
   The Keyword list supports up to 32 entries. Here are some sample entries:
   - Specify .com if you want to allow only sites with domain suffixes such as .edu or .gov.
   - Enter a period (.) to block all Internet browsing access.

Delete a Keyword or Domain

1. Select the keyword you want to delete from the list.
2. Click **Delete Keyword** and then **Apply** to save your changes.

Specify a Trusted Computer

You can exempt one trusted computer from blocking and logging. The computer you exempt has to have a fixed IP address.

1. In the Trusted IP Address field, enter the IP address.
2. Click **Apply** to save your changes.
Block Services (Port Filtering)

Services are functions performed by server computers at the request of client computers. For example, Web servers serve Web pages, time servers serve time and date information, and game hosts serve data about other players’ moves. When a computer on the Internet sends a request for service to a server computer, the requested service is identified by a service or port number. This number appears as the destination port number in the transmitted IP packets. For example, a packet that is sent with the destination port number 80 is an HTTP (Web server) request.

The service numbers for many common protocols are defined by the Internet Engineering Task Force (IETF at http://www.ietf.org/) and published in RFC1700, “Assigned Numbers.” Service numbers for other applications are typically chosen from the range 1024 to 65535 by the authors of the application. Although the router already holds a list of many service port numbers, you are not limited to these choices. You can often determine port number information by contacting the publisher of the application, by asking user groups or newsgroups, or by searching.

The Block Services screen lets you add and block specific Internet services by computers on your network. This is called service blocking or port filtering. To add a service for blocking, first determine which port number or range of numbers are used by the application.

To block services:

1. Select Advanced > Security > Block Services to display the following screen:

2. Select either Per Schedule or Always to enable service blocking, and click Apply. If you selected Per Schedule, specify a time period in the Schedule screen as described in Schedule Blocking on page 59.

3. Click Add to add a service. The Block Services Setup screen displays:
4. From the Service Type list, select the application or service to allow or block. The list already displays several common services, but you are not limited to these choices. To add any additional services or applications that do not already appear, select User Defined.

5. If you know that the application uses either TCP or UDP, select the appropriate protocol. If you are not sure, select Both.

6. Enter the starting and ending port numbers. If the application uses a single port number, enter that number in both fields.

7. Select the radio button for the IP address configuration you want to block, and enter the IP addresses. You can block the specified service for a single computer, a range of computers with consecutive IP addresses, or all computers on your network.

8. Click Add to enable your Block Services Setup selections.

Schedule Blocking

1. Select Advanced > Security > Schedule to display the following screen:
2. Set up the schedule for blocking keywords and services.
   a. **Days to Block.** Select days on which you want to apply blocking by selecting the appropriate check boxes, or select *Every Day* and select the check boxes for all days.
   b. **Time of Day to Block.** Select a start and end time in 24-hour format, or select *All Day* for 24-hour blocking.
3. Select your time zone from the list. If you use daylight savings time, select the *Automatically adjust for daylight savings time* check box.
4. Click **Apply** to save your settings.

**Security Event Email Notifications**

To receive logs and alerts by email, provide your email information in the Email screen and specify which alerts you want to receive and how often.

1. Select **Advanced > Security > Email** to display the following screen:

   ![Email Configuration Screen](image)

2. To receive email logs and alerts from the router, select the **Turn Email Notification On** check box.
3. In the **Your Outgoing Mail Server** field, enter the name of your ISP's outgoing (SMTP) mail server (such as mail.myISP.com). You might be able to find this information in the configuration screen of your email program. If you leave this field blank, log and alert messages are not sent by email.
4. Enter the email address to which logs and alerts are sent in the **Send to This Email Address** field. This email address is also used for the From address. If you leave this field blank, log and alert messages are not sent by email.
5. If your outgoing email server requires authentication, select the **My Mail Server requires authentication** check box. Fill in the **User Name** and **Password** fields for the outgoing email server.
6. You can have email alerts sent immediately when someone attempts to visit a blocked site and you can specify that logs are sent automatically.

   If you select the Weekly, Daily, or Hourly option and the log fills up before the specified period, the log is automatically emailed to the specified email address. After the log is sent, the log is cleared from the router’s memory. If the router cannot email the log file, the log buffer might fill up. In this case, the router overwrites the log and discards its contents.

7. Click **Apply** to save your settings.
This chapter describes the router settings for administering and maintaining your router and home network. See also *Remote Management* on page 101 for information on upgrading or checking the status of your router over the Internet, and *Traffic Meter* on page 104 for information on monitoring the volume of Internet traffic passing through your router’s Internet port.

This chapter includes the following sections:

- Upgrade the Router Firmware
- View Router Status
- View Logs of Web Access or Attempted Web Access
- Manage the Configuration File
- Set Up Time Machine
- Set Up Bonjour Printing on the Mac
- Set Up Bonjour Printing for Windows
Upgrade the Router Firmware

The router firmware (routing software) is stored in flash memory. You can update the firmware from the Administration menu on the Advanced tab. You might see a message at the top of the Genie screens when new firmware is available for your product.

You can use the Check button on the Firmware Update screen to check and update to the latest firmware for your product if new firmware is available.

To check for new firmware and update your router:

1. Select Advanced > Administration > Firmware Update to display the following screen:

2. Click Check.
   
   The router finds new firmware information if any is available.

3. Click Yes to update and locate the firmware you downloaded (the file ends in .img).

WARNING!

When uploading firmware to the router, do not interrupt the Web browser by closing the window, clicking a link, or loading a new page. If the browser is interrupted, it could corrupt the firmware.

When the upload is complete, your router restarts. The upgrade process typically takes about 1 minute. Read the new firmware release notes to determine whether or not you need to reconfigure the router after upgrading.
View Router Status

To view router status and usage information, click the Advanced Home button or select Administration > Router Status to display the following screen:

Router Information

**Hardware Version.** The router model.

**Firmware Version.** The version of the router firmware. It changes if you upgrade the router firmware.

**GUI Language Version.** The localized language of the GUI.

**LAN Port.**
- **MAC Address.** The Media Access Control address. This is the unique physical address being used by the Ethernet (LAN) port of the router.
- **IP Address.** The IP address being used by the Ethernet (LAN) port of the router. The default is 192.168.1.1.
- **DHCP Server.** Identifies whether the router’s built-in DHCP server is active for the LAN-attached devices.

Internet Provider (WAN) Setup

**MAC Address.** The Media Access Control address. This is the unique physical address being used by the Internet (WAN) port of the router.

**IP Address.** The IP address being used by the Internet (WAN) port of the router. If no address is shown or the address is 0.0.0, the router cannot connect to the Internet.
Connection. This shows if the router is using a fixed IP address on the WAN. If the value is DHCP Client, the router obtains an IP address dynamically from the ISP.

IP Subnet Mask. The IP subnet mask being used by the Internet (WAN) port of the router.

Domain Name Server. The Domain Name Server addresses being used by the router. A Domain Name Server translates human-language URLs such as www.netgear.com into IP addresses.

Statistics Button

On the Router Status screen, in the Internet Provider (WAN) Setup pane, click the Statistics button to display the following screen:

Figure 7. System up time and poll interval statistics

System Up Time. The time elapsed since the router was last restarted.

Port. The statistics for the WAN (Internet) and LAN (Ethernet) ports. For each port, the screen displays:

- **Status.** The link status of the port.
- **TxPkts.** The number of packets transmitted on this port since reset or manual clear.
- **RxPkts.** The number of packets received on this port since reset or manual clear.
- **Collisions.** The number of collisions on this port since reset or manual clear.
- **Tx B/s.** The current transmission (outbound) bandwidth used on the WAN and LAN ports.
- **Rx B/s.** The current reception (inbound) bandwidth used on the WAN and LAN ports.
- **Up Time.** The time elapsed since this port acquired the link.
- **Poll Interval.** The interval at which the statistics are updated in this screen.

To change the polling frequency, enter a time in seconds in the Poll Interval field, and click Set Interval.

To stop the polling entirely, click Stop.
**Connection Status Button**

On the Router Status screen in the Internet Connection pane, click the **Connection Status** button to view connection status information.

![Connection Status](image)

**Figure 8. View connection status information**

The Release button returns the status of all items to 0. The Renew button refreshes the items. The Close Window button closes the Connection Status screen.

- **IP Address**. The IP address that is assigned to the router.
- **Subnet Mask**. The subnet mask that is assigned to the router.
- **Default Gateway**. The IP address for the default gateway that the router communicates with.
- **DHCP Server**. The IP address for the Dynamic Host Configuration Protocol server that provides the TCP/IP configuration for all the computers that are connected to the router.
- **DNS Server**. The IP address of the Domain Name Service server that provides translation of network names to IP addresses.
- **Lease Obtained**. The date and time when the lease was obtained.
- **Lease Expires**. The date and time that the lease expires.
### Wireless Settings (2.4 GHz) and Wireless Settings (5 GHz)

You need to scroll down to see all the fields for this section of the Router Status screen:

![Router Status Screen](image)

The following settings are displayed for each network:

**Name (SSID).** The wireless network name (SSID) used by the router. The default names for the 5 GHz ends in -5G to distinguish it from the 2.4 GHz network.

**Region.** The geographic region where the router is being used. It might be illegal to use the wireless features of the router in some parts of the world.

**Channel.** Identifies the operating channel of the wireless port being used. The default channel is Auto. When Auto is selected, the router will find the best operating channel available. If you notice interference from nearby devices, you can select a different channel. Channels 1, 6, and 11 will not interfere with each other.

**Mode.** Indicates the wireless communication mode: Up to 54Mbps, Up to 130Mbps (default), and Up to 300Mbps.

**Wireless AP.** Indicates whether the radio feature of the router is enabled. If this feature is not enabled, the Wireless LED on the front panel is off.

**Broadcast Name.** Indicates whether the router is broadcasting its SSID.

**Wi-Fi Protected Setup.** Indicates whether Wi-Fi Protected Setup is configured for this network.

### Guest Network (2.4 GHz) and Guest Network (5 GHz)

To need to scroll down in order to view this portion of the Router Status screen.

![Guest Network Screen](image)
Name (SSID). The 11N wireless network name (SSID) used by the router. The default names are NETGEAR-Guest and NETGEAR-5G-Guest.

Wireless AP. Indicates whether the radio feature of the router is enabled. If this feature is not enabled, the Wireless LED on the front panel is off.

Wireless Isolation. Select this check box only if you want to prevent wireless connections to the router.

Allow guest to access My Local Network. If selected, any user who connects to this SSID can access local networks associated with the router.

View Logs of Web Access or Attempted Web Access

The log is a detailed record of the websites you have accessed or attempted to access. Up to 256 entries are stored in the log. Log entries appear only when keyword blocking is enabled and no log entries are made for the trusted user.

Select Advanced > Administration > Logs. The Logs screen displays.

The log screen shows the following information:

- **Date and time.** The date and time the log entry was recorded.
- **Source IP.** The IP address of the initiating device for this log entry.
- **Target address.** The name or IP address of the website or news group visited or to which access was attempted.
- **Action.** Whether the access was blocked or allowed.

To refresh the log screen, click the Refresh button.

To clear the log entries, click the Clear Log button.

To email the log immediately, click the Send Log button.
Manage the Configuration File

The configuration settings of the WNDRMAC router are stored within the router in a configuration file. You can back up (save) this file to your computer, restore it, or reset it to the factory default settings.

Back Up

1. Select Advanced > Administration > Backup Settings to display the following screen:

![Backup Settings Screen]

2. Click Back Up to save a copy of the current settings.
3. Choose a location to store the .cfg file that is on a computer on your network.

Restore

1. Enter the full path to the file on your network, or click the Browse button to find the file.
2. When you have located the .cfg file, click the Restore button to upload the file to the router. Upon completion, the router reboots.

**WARNING!**

Do not interrupt the reboot process.

Erase

Under some circumstances (for example, if you move the router to a different network or if you have forgotten the password), you might want to erase the configuration and restore the factory default settings.
You can either use the Restore Factory Settings button on the back of the router (see Factory Default Settings on page 114), or you can click the Erase button in this screen.

Erase sets the user name to admin, the password to password, and the LAN IP address to 192.168.1.1, and enables the router’s DHCP.

Set Password

This feature allows you to change the default password that is used to log in to the router with the user name admin.

This is not the same as changing the password for wireless access. The label on the bottom of your router shows your unique wireless network name (SSID) and password for wireless access (see Label on page 10).

To set the password for the user name admin:

1. Select Advanced > Administration > Set Password to display the following screen:

![Set Password Screen](image)

2. Type the old password and type the new password twice in the fields on this screen.

3. If you want to be able to recover the password, select the Enable Password Recovery check box.

4. Click Apply so that your changes take effect.

Password Recovery

NETGEAR recommends that you enable password recovery if you change the password for the router’s user name of admin. Then you will have an easy way to recover the password if it is forgotten. This recovery process is supported in Internet Explorer, Firefox, and Chrome browsers, but not in the Safari browser.
To enable password recovery:

1. Select the **Enable Password Recovery** check box.
2. Select two security questions and provide answers to them.
3. Click **Apply** to save your changes.

When you use your browser to access the router, the log in window displays. If password recovery is enabled, when you click Cancel, the password recovery process starts. You can then enter the saved answers to the security questions to recover the password.

**Set Up Time Machine**

Time Machine works on Mac computers only, and automatically backs up everything on your computer to a USB hard drive connected to it.

**To set up Time Machine:**

**Note:** If you are already using Time Machine software with your USB hard drive, you can skip Steps 1 through 3 and go to Step 4.

1. Physically connect the USB hard drive to your Mac.
2. On your Mac, go to the magnifying glass at the top right of the desktop, and search for **disk utility**.
3. Open the Disk Utility and format your drive, as shown here.
The router supports GUID and MBR partitions only. To see how to change the partition scheme, see Change the Partition Scheme on page 77.

You can now use Time Machine wirelessly by connecting the USB hard drive to your router.

To access the connected USB hard drive from your Mac or PC:

1. Start ReadySHARE:
   • On a Mac: Select Go > Connect to Server, and then type: `smb://readyshare`
   • On a PC: Select Start > Run, and then type: `\readyshare`
2. From your MAC desktop, open Macintosh HD.
3. Click the Connect As button. In the pop-up window, select Registered User, and enter admin as the user name and password as the password. Click Connect.
4. After connecting successfully, you can list your connected devices. Note that you see one extra device, called admin, whenever you log in as admin.

**Note:** If you are backing up a large amount of data, before you continue, see Before You Back up a Large Amount of Data on page 73.
5. Click the **Use for Backup** button to complete your selection.

6. Enter the password (the same one you use to log in to the router as admin) and backup begins.

**Before You Back up a Large Amount of Data**

Before you back up a large amount of data with Time Machine, NETGEAR recommends that you do the following to ensure a successful operation:

1. Upgrade the operating system of the Mac machine.
2. Verify and repair the backup disk and the local disk.
3. Verify and repair the permissions on the local disk.
4. Set Energy Saver.
   a. From the Apple menu, select **System Preferences**.
   b. From the View menu, select **Energy Saver**.
c. On the Energy Saver screen, select **Wake for Ethernet network access**.

![Energy Saver Screen]


d. Click the Back arrow to exit this screen. Your changes will be saved.

Now, modify your Spotlight settings as described in the following section

**To modify your Spotlight settings:**

1. From the Apple menu, select **System Preferences**.
2. Click **Spotlight**.
3. On the Spotlight screen, click **Privacy**.

![Spotlight Screen]
4. On the Privacy screen, click Add (+).

5. From the Finder, select WNDRMAC from the list of shared devices (that you want to exclude from backups).

6. If readyshare is available on the Finder list, exclude it from Spotlight (Privacy) as you did for the WNDRMAC shared disk in the previous step.
7. When Time Machine Backups is shown on the Finder list, exclude it from Spotlight (Privacy) as you did for WNDRMAC and readyshare.

Your Spotlight settings will look like the following screen when you are finished:

Modify your Security settings as described in the following section.
To modify your Security settings:

1. From the Apple menu, select **System Preferences**.
2. From the View menu, select **Security**.
3. On the Security screen, leave the **Log out after minutes of inactivity** check box unchecked.

![Security settings](image)

**Change the Partition Scheme**

To run with the router, the partition scheme on your Mac has to be set to either GUID or MBR.

**To make sure the partition scheme is set to one of these supported schemes:**

1. Open the Disk Utility and select your USB drive.
2. Select the **Partition** tab.
3. Select **Volume Scheme** and set the number of partitions you would like to use.
5. Select **GUID Partition Table** or **Master Boot Record** (MBR).
6. Click **OK**.
Set Up Bonjour Printing on the Mac

1. Connect your USB printer to the WNDRMAC router.
2. Open up your **System Preferences**.
3. Then select **Print & Fax**.
4. Click the + button to add a Printer.
5. Select the printer from the list and select **Add**.

![Add Printer](image1)

6. The printer is added to the Printers window.

![Printers Window](image2)

You can now begin printing.
Set Up Bonjour Printing for Windows

2. Click BonjourPSSetup.exe to start the installation.
3. Follow the install wizard to complete the installation.
4. When the installation is complete, click the desktop shortcut Bonjour Printer Wizard.

5. Select the printer you want from the list and click Next.

6. To install the printer driver, select the driver from the list, or click Have Disk if you have a specific driver for this printer.

7. Step 7: Click Next to continue installing the printer.

Your printer installation is complete.
This chapter describes the advanced features of your router. The information is for users with a solid understanding of networking concepts who want to set the router up for unique situations such as when remote access from the Internet by IP or domain name is needed.

This chapter includes the following sections:

- Advanced Wireless Settings
- Wireless Repeating Function (WDS)
- Port Forwarding and Triggering
- Set Up Port Forwarding to Local Servers
- Set Up Port Triggering
- Dynamic DNS
- Static Routes
- Remote Management
- USB Settings
- Universal Plug and Play
- IPv6
- Traffic Meter
Advanced Wireless Settings

Select Advanced > Advanced Setup > Wireless Settings to display the following screen:

The following settings are available in this screen:

**Enable Wireless Router Radio.** You can completely turn off the wireless portion of the wireless router by clearing this check box. Select this check box again to enable the wireless portion of the router. When the wireless radio is disabled, other members of your household can use the router by connecting their computers to the router with an Ethernet cable.

**Note:** The Fragmentation Length, CTS/RTS Threshold, and Preamble Mode options are reserved for wireless testing and advanced configuration only. Do not change these settings.

**Transmit Power Control.** With the default setting of 100%, the router uses the power level that NETGEAR recommends to transmit wireless packets. If you change this setting to a lower percentage, it saves power, but also reduces wireless coverages.

**Turn off wireless signal by schedule.** You can use this feature to turn off the wireless signal from your router at times when you do not need a wireless connection. For instance, you could turn it off for the weekend if you leave town.

**WPS Settings.** You can add WPS devices to your network.

**Wireless Card Access List.** Click the Set Up Access List button display the Wireless Card Access List screen. On this screen you can restrict access to your network to specific devices based on their MAC address.
Wireless Repeating Function (WDS)

You can set the WNDRMAC router up to be used as a wireless access point (AP). Doing this enables the router to act as a wireless repeater. A wireless repeater connects to another wireless router as a client where the network to which it connects becomes the ISP service.

Wireless repeating is a type of Wireless Distribution System (WDS). A WDS allows a wireless network to be expanded through multiple access points instead of using a wired backbone to link them. The following figure shows a wireless repeating scenario.

![Wireless Repeating Scenario](image)

**Figure 9. Wireless repeating scenario**

**Note:** If you use the wireless repeating function, you need to select either WEP or None as a security option in the Wireless Settings screen. The WEP option displays only if you select the wireless mode Up to 54Mbps in the Wireless Settings screen.

**Wireless Base Station.** The router acts as the parent access point, bridging traffic to and from the child repeater access point, as well as handling wireless and wired local computers. To configure this mode, you have to know the MAC addresses of the child repeater access point.
**Wireless Repeater.** The router sends all traffic from its local wireless or wired computers to a remote access point. To configure this mode, you have to know the MAC address of the remote parent access point.

The WNDRMAC router is always in dual band concurrent mode, unless you turn off one radio. Be aware that if you enable the wireless repeater in either radio band, the wireless base station or wireless repeater cannot be enabled in the other radio band. However, if you enable the wireless base station in either radio band and use the other radio band as a wireless router or wireless base station, dual band concurrent mode is not affected.

For you to set up a wireless network with WDS, the following conditions have to be met for both access points:

- Both access points have to use the same SSID, wireless channel, and encryption mode.
- Both access points have to be on the same LAN IP subnet. That is, all the access point LAN IP addresses are in the same network.
- All LAN devices (wired and wireless computers) have to be configured to operate in the same LAN network address range as the access points.

**Wireless Repeating Function**

Select **Advanced > Advanced Setup > Wireless Repeating Function** to view or change wireless repeater settings for the router.

The set of fields is the same for the 2.4 GHz or 5 GHz wireless network.

- **Enable Wireless Repeating Function (2.4 GHz/5 GHz).** Select the check box for the 2.4 GHz or 5 GHz network to use the wireless repeating function.
- **Wireless MAC of this router.** This field displays the MAC address for your router for your reference. You will need to enter this MAC address in the corresponding Wireless Repeating Function screen of the other access point you are using.
• **Wireless Repeater.** If your router is the repeater, select this check box.

  **Repeater IP Address.** If your router is the repeater, enter the IP address of the other access point.

  **Disable Wireless Client Association.** If your router is the repeater, selecting this check box means that wireless clients cannot associate with it. Only LAN client associations are allowed.

  - If you are setting up a point-to-point bridge, select this check box.
  - If you want all client traffic to go through the other access point (repeater with wireless client association), leave this check box cleared.

  **Base Station MAC Address.** If your router is the repeater, enter the MAC address for the access point that is the base station.

• **Wireless Base Station.** If your router is the base station, select this check box.

  **Disable Wireless Client Association.** If your router is the base station, selecting this check box means that wireless clients cannot associate with it. Only LAN client associations are allowed.

  **Repeater MAC Address (1 through 4).** If your router is the base station, it can act as the “parent” of up to 4 other access points. Enter the MAC addresses of the other access points in these fields.

**Set Up the Base Station**

The wireless repeating function works only in hub and spoke mode. The units cannot be daisy-chained. You have to know the wireless settings for both units. You have to know the MAC address of the remote unit. First, set up the base station, and then set up the repeater.

**To set up the base station:**

1. Set up both units with exactly the same wireless settings (SSID, mode, channel, and security). Note that the wireless security option has to be set to None or WEP.
2. Select **Advanced > Advanced Setup > Wireless Repeating Function** to display the Wireless Repeating Function screen.

3. In the Wireless Repeating Function screen (depending on the frequency you want to use), select the **Enable Wireless Repeating Function** check box and select the **Wireless Base Station** radio button.

4. Enter the MAC address for one or more repeater units.

5. Click **Apply** to save your changes.

### Set Up a Repeater Unit

Use a wired Ethernet connection to set up the repeater unit to avoid conflicts with the wireless connection to the base station.

---

**Note:** If you are using the WNDRMAC base station with a non-NETGEAR router as the repeater, you might need to change additional configuration settings. In particular, you should disable the DHCP server function on the wireless repeater AP.

---

**To configure the router as a repeater unit:**

1. Log in to the router that will be the repeater. Select **Basic > Wireless Settings** and verify that the wireless settings match the base unit exactly. The wireless security option has to be set to **WEP** or **None**.

2. Select **Advanced > Wireless Repeating Function**, and select the **Enable Wireless Repeating Function** check box and the **Wireless Repeater** radio button.
3. Fill in the Repeater IP Address field. This IP address has to be in the same subnet as the base station, but different from the LAN IP of the base station.

4. Click **Apply** to save your changes.

5. Verify connectivity across the LANs.

   A computer on any wireless or wired LAN segment of the router should be able to connect to the Internet or share files and printers with any other wireless or wired computer or server connected to the other access point.

### Port Forwarding and Triggering

By default, the router blocks inbound traffic from the Internet to your computers except replies to your outbound traffic. You might need to create exceptions to this rule for these purposes:

- To allow remote computers on the Internet to access a server on your local network.
- To allow certain applications and games to work correctly when their replies are not recognized by your router.

Your router provides two features for creating these exceptions: port forwarding and port triggering. The next sections provide background information to help you understand how port forwarding and port triggering work, and the differences between the two.

### Remote Computer Access Basics

When a computer on your network needs to access a computer on the Internet, your computer sends your router a message containing the source and destination address and process information. Before forwarding your message to the remote computer, your router has to modify the source information and create and track the communication session so that replies can be routed back to your computer.

Here is an example of normal outbound traffic and the resulting inbound responses:

1. You open a browser and your operating system assigns port number 5678 to this browser session.

2. You type `http://www.example.com` into the URL field and your computer creates a Web page request message with the following address and port information. The request message is sent to your router.

   **Source address.** Your computer's IP address.

   **Source port number.** 5678, which is the browser session.

   **Destination address.** The IP address of www.example.com, which your computer finds by asking a DNS server.

   **Destination port number.** 80, which is the standard port number for a Web server process.

3. Your router creates an entry in its internal session table describing this communication session between your computer and the Web server at www.example.com.
the Web page request message to www.example.com, your router stores the original information and then modifies the source information in the request message, performing Network Address Translation (NAT):

- The source address is replaced with your router’s public IP address. This is necessary because your computer uses a private IP address that is not globally unique and cannot be used on the Internet.
- The source port number is changed to a number chosen by the router, such as 33333. This is necessary because two computers could independently be using the same session number.

Your router then sends this request message through the Internet to the Web server at www.example.com.

4. The Web server at www.example.com composes a return message with the requested Web page data. The return message contains the following address and port information. The Web server then sends this reply message to your router.

   **Source address.** The IP address of www.example.com.

   **Source port number.** 80, which is the standard port number for a Web server process.

   **Destination address.** The public IP address of your router.

   **Destination port number.** 33333.

5. Upon receiving the incoming message, your router checks its session table to determine whether there is an active session for port number 33333. Finding an active session, the router then modifies the message to restore the original address information replaced by NAT. Your router sends this reply message to your computer, which displays the Web page from www.example.com. The message now contains the following address and port information.

   **Source address.** The IP address of www.example.com.

   **Source port number.** 80, which is the standard port number for a Web server process.

   **Destination address.** Your computer’s IP address.

   **Destination port number.** 5678, which is the browser session that made the initial request.

6. When you finish your browser session, your router eventually detects a period of inactivity in the communications. Your router then removes the session information from its session table and incoming traffic is no longer accepted on port number 33333.

**Port Triggering to Open Incoming Ports**

In the preceding example, requests are sent to a remote computer by your router from a particular service port number, and replies from the remote computer to your router are directed to that port number. If the remote server sends a reply back to a different port number, your router does not recognize it and discards it. However, some application servers (such as FTP and IRC servers) send replies back to multiple port numbers. Using the port triggering function of your router, you can tell the router to open additional incoming ports when a particular outgoing port originates a session.
An example is Internet Relay Chat (IRC). Your computer connects to an IRC server at destination port 6667. The IRC server not only responds to your originating source port, but also sends an “identify” message to your computer on port 113. Using port triggering, you can tell the router, “When you initiate a session with destination port 6667, you have to also allow incoming traffic on port 113 to reach the originating computer.” Using steps similar to the preceding example, the following sequence shows the effects of the port triggering rule you have defined:

1. You open an IRC client program to start a chat session on your computer.
2. Your IRC client composes a request message to an IRC server using a destination port number of 6667, the standard port number for an IRC server process. Your computer then sends this request message to your router.
3. Your router creates an entry in its internal session table describing this communication session between your computer and the IRC server. Your router stores the original information, performs Network Address Translation (NAT) on the source address and port, and sends this request message through the Internet to the IRC server.
4. Noting your port triggering rule and having observed the destination port number of 6667, your router creates an additional session entry to send any incoming port 113 traffic to your computer.
5. The IRC server sends a return message to your router using the NAT-assigned source port (as in the previous example, let’s say port 33333) as the destination port. The IRC server also sends an “identify” message to your router with destination port 113.
6. Upon receiving the incoming message to destination port 33333, your router checks its session table to determine whether there is an active session for port number 33333. Finding an active session, the router restores the original address information replaced by NAT and sends this reply message to your computer.
7. Upon receiving the incoming message to destination port 113, your router checks its session table and learns that there is an active session for port 113, associated with your computer. The router replaces the message’s destination IP address with your computer’s IP address and forwards the message to your computer.
8. When you finish your chat session, your router eventually senses a period of inactivity in the communications. The router then removes the session information from its session table, and incoming traffic is no longer accepted on port numbers 33333 or 113.

To configure port triggering, you need to know which inbound ports the application needs. Also, you need to know the number of the outbound port that will trigger the opening of the inbound ports. You can usually determine this information by contacting the publisher of the application, or user groups or newsgroups.

---

**Note:** Only one computer at a time can use the triggered application.

---

**Port Forwarding to Permit External Host Communications**

In both of the preceding examples, your computer initiates an application session with a server computer on the Internet. However, you might need to allow a client computer on the
Internet to initiate a connection to a server computer on your network. Normally, your router ignores any inbound traffic that is not a response to your own outbound traffic. You can configure exceptions to this default rule by using the port forwarding feature.

A typical application of port forwarding can be shown by reversing the client-server relationship from the previous Web server example. In this case, a remote computer’s browser needs to access a Web server running on a computer in your local network. Using port forwarding, you can tell the router, “When you receive incoming traffic on port 80 (the standard port number for a Web server process), forward it to the local computer at 192.168.1.123.” The following sequence shows the effects of the port forwarding rule you have defined:

1. The user of a remote computer opens a browser and requests a Web page from www.example.com, which resolves to the public IP address of your router. The remote computer composes a Web page request message with the following destination information:

   **Destination address.** The IP address of www.example.com, which is the address of your router.

   **Destination port number.** 80, which is the standard port number for a Web server process.

   The remote computer then sends this request message through the Internet to your router.

2. Your router receives the request message and looks in its rules table for any rules covering the disposition of incoming port 80 traffic. Your port forwarding rule specifies that incoming port 80 traffic should be forwarded to local IP address 192.168.1.123. Therefore, your router modifies the destination information in the request message:

   The destination address is replaced with 192.168.1.123.

   Your router then sends this request message to your local network.

3. Your Web server at 192.168.1.123 receives the request and composes a return message with the requested Web page data. Your Web server then sends this reply message to your router.

4. Your router performs Network Address Translation (NAT) on the source IP address, and sends this request message through the Internet to the remote computer, which displays the Web page from www.example.com.

To configure port forwarding, you need to know which inbound ports the application needs. You usually can determine this information by contacting the publisher of the application or the relevant user groups and newsgroups.

**How Port Forwarding Differs from Port Triggering**

The following points summarize the differences between port forwarding and port triggering:

- Port triggering can be used by any computer on your network, although only one computer can use it at a time.
- Port forwarding is configured for a single computer on your network.

Advanced Settings
• Port triggering does require that you need to know the computer’s IP address in advance. The IP address is captured automatically.
• Port forwarding requires that you specify the computer’s IP address during configuration, and the IP address can never change.
• Port triggering requires specific outbound traffic to open the inbound ports, and the triggered ports are closed after a period of no activity.
• Port forwarding is always active and does not need to be triggered.

Set Up Port Forwarding to Local Servers

Using the port forwarding feature, you can allow certain types of incoming traffic to reach servers on your local network. For example, you might want to make a local Web server, FTP server, or game server visible and available to the Internet.

Use the Port Forwarding screen to configure the router to forward specific incoming protocols to computers on your local network. In addition to servers for specific applications, you can also specify a default DMZ server to which all other incoming protocols are forwarded.

Before starting, you need to determine which type of service, application, or game you want to provide, and the local IP address of the computer that will provide the service. The server computer has to always have the same IP address.

To set up port forwarding:

**Tip:** To ensure that your server computer always has the same IP address, use the reserved IP address feature of your WNDRMAC router.
1. Select Advanced Setup > Port Forwarding/Port Triggering to display the following screen:

The Port Forwarding radio button is selected as the service type.

2. From the Service Name list, select the service or game that you will host on your network. If the service does not appear in the list, see *Add a Custom Service* on page 93.

3. In the corresponding Server IP Address field, enter the last digit of the IP address of your local computer that will provide this service.

4. Click Add. The service appears in the list in the screen.

**Add a Custom Service**

To define a service, game, or application that does not appear in the Service Name list, you have to first determine which port number or range of numbers is used by the application. You can usually determine this information by contacting the publisher of the application or user groups or newsgroups.

**To add a custom service:**

1. Select Advanced > Advanced Setup > Port Forwarding/Port Triggering.
2. Select the Port Forwarding radio button as the service type.
3. Click the **Add Custom Service** button to display the following screen:

![Add Custom Service screen](image)

4. In the **Service Name** field, enter a descriptive name.
5. In the **Protocol** field, select the protocol. If you are unsure, select **TCP/UDP**.
6. In the **Starting Port** field, enter the beginning port number.
   - If the application uses a single port, enter the same port number in the **Ending Port** field.
   - If the application uses a range of ports, enter the ending port number of the range in the **Ending Port** field.
7. In the **Server IP Address** field, enter the IP address of your local computer that will provide this service.
8. Click **Apply**. The service appears in the list in the Port Forwarding/Port Triggering screen.

### Editing or Deleting a Port Forwarding Entry

**To edit or delete a port forwarding entry:**

1. In the table, select the radio button next to the service name.
2. Click **Edit Service** or **Delete Service**.

**Application Example: Making a Local Web Server Public**

If you host a Web server on your local network, you can use port forwarding to allow Web requests from anyone on the Internet to reach your Web server.
To make a local Web server public:

1. Assign your Web server either a fixed IP address or a dynamic IP address using DHCP address reservation. In this example, your router will always give your Web server an IP address of 192.168.1.33.
2. In the Port Forwarding screen, configure the router to forward the HTTP service to the local address of your Web server at 192.168.1.33. HTTP (port 80) is the standard protocol for Web servers.
3. (Optional) Register a host name with a Dynamic DNS service, and configure your router to use the name as described in Dynamic DNS on page 97. To access your Web server from the Internet, a remote user has to know the IP address that has been assigned by your ISP. However, if you use a Dynamic DNS service, the remote user can reach your server by a user-friendly Internet name, such as mynetgear.dyndns.org.

Set Up Port Triggering

Port triggering is a dynamic extension of port forwarding that is useful in these cases:

- More than one local computer needs port forwarding for the same application (but not simultaneously).
- An application needs to open incoming ports that are different from the outgoing port.

When port triggering is enabled, the router monitors outbound traffic looking for a specified outbound “trigger” port. When the router detects outbound traffic on that port, it remembers the IP address of the local computer that sent the data. The router then temporarily opens the specified incoming port or ports, and forwards incoming traffic on the triggered ports to the triggering computer.

While port forwarding creates a static mapping of a port number or range to a single local computer, port triggering can dynamically open ports to any computer that needs them and can close the ports when they are no longer needed.

---

**Note:** If you use applications such as multiplayer gaming, peer-to-peer connections, real-time communications such as instant messaging, or remote assistance (a feature in Windows XP), you should also enable Universal Plug and Play (UPnP) according to the instructions in Universal Plug and Play on page 102.

---

To set up port triggering, you need to know which inbound ports the application needs. Also, you need to know the number of the outbound port that will trigger the opening of the inbound ports. You can usually determine this information by contacting the publisher of the application or user groups or newsgroups.

To set up port triggering:

1. Select Advanced > Advanced Setup > Port Forwarding/Port Triggering.
2. Select the **Port Triggering** radio button to display the port triggering information.

3. Clear the **Disable Port Triggering** check box.

   **Note:** If the Disable Port Triggering check box is selected after you configure port triggering, port triggering is disabled. However, any port triggering configuration information you added to the router is retained even though it is not used.

4. In the Port Triggering Timeout field, enter a value up to 9999 minutes.

5. This value controls the inactivity timer for the designated inbound ports. The inbound ports close when the inactivity time expires. This is required because the router cannot be sure when the application has terminated.
6. Click **Add Service** to display the following screen:

7. In the Service Name field, type a descriptive service name.

8. In the Service User field, select **Any** (the default) to allow this service to be used by any computer on the Internet. Otherwise, select **Single address**, and enter the IP address of one computer to restrict the service to a particular computer.

9. Select the service type, either **TCP** or **UDP** or both (TCP/UDP). If you are not sure, select TCP/UDP.

10. In the Triggering Port field, enter the number of the outbound traffic port that will cause the inbound ports to be opened.

11. Enter the inbound connection port information in the Connection Type, Starting Port, and Ending Port fields.

12. Click **Apply**. The service appears in the Port Triggering Portmap table.

---

**Dynamic DNS**

If your Internet service provider (ISP) gave you a permanently assigned IP address, you can register a domain name and have that name linked with your IP address by public Domain Name Servers (DNS). However, if your Internet account uses a dynamically assigned IP address, you do not know in advance what your IP address will be, and the address can change frequently. In this case, you can use a commercial Dynamic DNS service. This type of service lets you register your domain to their IP address and forwards traffic directed at your domain to your frequently changing IP address.

If your ISP assigns a private WAN IP address (such as 192.168.x.x or 10.x.x.x), the Dynamic DNS service will not work because private addresses are not routed on the Internet.

Your router contains a client that can connect to the Dynamic DNS service provided by DynDNS.org. First visit their website at [http://www.dyndns.org](http://www.dyndns.org) and obtain an account and...
host name that you configure in the router. Then, whenever your ISP-assigned IP address changes, your router automatically contacts the Dynamic DNS service provider, logs in to your account, and registers your new IP address. If your host name is hostname, for example, you can reach your router at http://hostname.dyndns.org.

On the Advanced tab, select Advanced Setup > Dynamic DNS to display the following screen:

![Figure 10. Forward traffic to a changing IP address](image)

**To set up Dynamic DNS:**

1. Register for an account with one of the Dynamic DNS service providers whose names appear in the Service Provider list. For example, for DynDNS.org, select www.dyndns.org.
2. Select the **Use a Dynamic DNS Service** check box.
3. Select the name of your Dynamic DNS service provider.
4. Type the host name (or domain name) that your Dynamic DNS service provider gave you.
5. Type the user name for your Dynamic DNS account. This is the name that you use to log in to your account, not your host name.
6. Type the password (or key) for your Dynamic DNS account.
7. If your Dynamic DNS provider allows the use of wildcards in resolving your URL, you can select the **Use Wildcards** check box to activate this feature.
   
   For example, the wildcard feature causes *.yourhost.dyndns.org to be aliased to the same IP address as yourhost.dyndns.org.
8. Click **Apply** to save your configuration.
Static Routes

Static routes provide additional routing information to your router. Under usual circumstances, the router has adequate routing information after it has been configured for Internet access, and you do not need to configure additional static routes. You have to configure static routes only for unusual cases such as multiple routers or multiple IP subnets located on your network.

As an example of when a static route is needed, consider the following case:

- Your primary Internet access is through a cable modem to an ISP.
- You have an ISDN router on your home network for connecting to the company where you are employed. This router’s address on your LAN is 192.168.1.100.
- Your company’s network address is 134.177.0.0.

When you first configured your router, two implicit static routes were created. A default route was created with your ISP as the gateway, and a second static route was created to your local network for all 192.168.1.x addresses. With this configuration, if you attempt to access a device on the 134.177.0.0 network, your router forwards your request to the ISP. The ISP forwards your request to the company where you are employed, and the request is likely to be denied by the company’s firewall.

In this case you have to define a static route, telling your router that 134.177.0.0 should be accessed through the ISDN router at 192.168.1.100. In this example:

- The Destination IP Address and IP Subnet Mask fields specify that this static route applies to all 134.177.x.x addresses.
- The Gateway IP Address field specifies that all traffic for these addresses should be forwarded to the ISDN router at 192.168.1.100.
- A metric value of 1 will work since the ISDN router is on the LAN.
- Private is selected only as a precautionary security measure in case RIP is activated.
To set up a static route:

1. Select Advanced > Advanced Setup > Static Routes to display the following screen:

![Static Routes Screen]

2. In the Route Name field, type a name for this static route (for identification purposes only.)

3. Select the Private check box if you want to limit access to the LAN only. If Private is selected, the static route is not reported in RIP.

4. Select the Active check box to make this route effective.

5. Type the destination IP address of the final destination.

6. Type the IP subnet mask for this destination. If the destination is a single host, type 255.255.255.255.

7. Type the gateway IP address, which has to be a router on the same LAN segment as the WNDRMAC router.

8. Type a number between 1 and 15 as the metric value.
   This value represents the number of routers between your network and the destination. Usually, a setting of 2 or 3 works, but if this is a direct connection, set it to 1.

9. Click Apply to add the static route.
Remote Management

The remote management feature lets you upgrade or check the status of your WNDRMAC router over the Internet.


![Remote Management Interface](image)

**Note:** Be sure to change the router’s default login password to a very secure password. The ideal password should contain no dictionary words from any language and contain uppercase and lowercase letters, numbers, and symbols. It can be up to 30 characters.

2. Select the Turn Remote Management On check box.

3. Under Allow Remote Access By, specify the external IP addresses to be allowed to access the router’s remote management.

   **Note:** For enhanced security, restrict access to as few external IP addresses as practical.

   - To allow access from a single IP address on the Internet, select Only This Computer. Enter the IP address that will be allowed access.
   - To allow access from a range of IP addresses on the Internet, select IP Address Range. Enter a beginning and ending IP address to define the allowed range.
   - To allow access from any IP address on the Internet, select Everyone.

4. Specify the port number for accessing the management interface.

   Normal Web browser access uses the standard HTTP service port 80. For greater security, enter a custom port number for the remote management Web interface. Choose...
a number between 1024 and 65535, but do not use the number of any common service
port. The default is 8080, which is a common alternate for HTTP.

5. Click Apply to have your changes take effect.

6. When accessing your router from the Internet, type your router’s WAN IP address into your
browser’s address or location field followed by a colon (:) and the custom port number. For
example, if your external address is 134.177.0.123 and you use port number 8080, enter
http://134.177.0.123:8080 in your browser.

**USB Settings**

For added security, the router can be set up to share only approved USB devices. See
Specify Approved USB Devices on page 54 for the procedure.

**Universal Plug and Play**

Universal Plug and Play (UPnP) helps devices, such as Internet appliances and computers,
to access the network and connect to other devices as needed. UPnP devices can
automatically discover the services from other registered UPnP devices on the network.

---

**Note:** If you use applications such as multiplayer gaming, peer-to-peer
connections, or real-time communications such as instant
messaging or remote assistance (a feature in Windows XP), you
should enable UPnP.
To turn on Universal Plug and Play:


![UPnP Screen](image)

2. The available settings and information in this screen are:

   **Turn UPnP On.** UPnP can be enabled or disabled for automatic device configuration. The default setting for UPnP is disabled. If this check box is not selected, the router does not allow any device to automatically control the resources, such as port forwarding (mapping) of the router.

   **Advertisement Period.** The advertisement period is how often the router broadcasts its UPnP information. This value can range from 1 to 1440 minutes. The default period is 30 minutes. Shorter durations ensure that control points have current device status at the expense of additional network traffic. Longer durations can compromise the freshness of the device status, but can significantly reduce network traffic.

   **Advertisement Time to Live.** The time to live for the advertisement is measured in hops (steps) for each UPnP packet sent. The time to live hop count is the number of steps a broadcast packet is allowed to propagate for each UPnP advertisement before it disappears. The number of hops can range from 1 to 255. The default value for the advertisement time to live is 4 hops, which should be fine for most home networks. If you notice that some devices are not being updated or reached correctly, then it might be necessary to increase this value.

   **UPnP Portmap Table.** The UPnP Portmap Table displays the IP address of each UPnP device that is currently accessing the router and which ports (internal and external) that device has opened. The UPnP Portmap Table also displays what type of port is open and whether that port is still active for each IP address.

3. Click **Apply** to save your settings.
IPv6

This screen allows you to set up an IPv6 Internet connection type.

1. Select **Advanced > Advanced Setup > IPv6** to display the following screen:

2. Select the IPv6 connection type from the list. Your Internet service provider (ISP) can provide this information.
   - If your ISP did not provide details, you can select **IPv6 Tunnel**.
   - If you are not sure, select **Auto Detect** so that the router detects the IPv6 type that is in use.
   - If your Internet connection does not use PPPoE, DHCP, or fixed, but is IPv6, then select **IPv6 auto config**.

3. Click **Apply** so that your changes take effect.

Traffic Meter

Traffic metering allows you to monitor the volume of Internet traffic passing through your router’s Internet port. With the Traffic Meter utility, you can set limits for traffic volume, set a monthly limit, and get a live update of traffic usage.
To monitor Internet traffic:

1. Click Advanced > Advanced Setup > Traffic Meter to display the following screen:

2. To enable the Traffic Meter, select the Enable Traffic Meter check box.

3. If you would like to record and restrict the volume of Internet traffic, select the Traffic volume control by radio button. You can select one of the following options for controlling the traffic volume:
   - No Limit. No restriction is applied when the traffic limit is reached.
   - Download only. The restriction is applied to incoming traffic only.
   - Both Directions. The restriction is applied to both incoming and outgoing traffic.

4. You can limit the amount of data traffic allowed per month by specifying how many Mbytes per month are allowed or by specifying how many hours of traffic are allowed.

5. Set the Traffic Counter to begin at a specific time and date.

6. Set up Traffic Control to issue a warning message before the monthly limit of Mbytes or hours is reached. You can select one of the following to occur when the limit is attained:
   - The Internet LED flashes green or amber.
   - The Internet connection is disconnected and disabled.

7. Set up Internet Traffic Statistics to monitor the data traffic.

8. Click the Traffic Status button to get a live update on Internet traffic status on your router.

9. Click Apply to save your settings.
This chapter provides information to help you diagnose and solve problems you might have with your router. If you do not find the solution here, check the NETGEAR support site at http://support.netgear.com for product and contact information.

This chapter contains the following sections:

- Quick Tips
- Troubleshooting with the LEDs
- Cannot Log In to the Router
- Cannot Access the Internet
- Changes Not Saved
- Incorrect Date or Time
- Wireless Connectivity
Quick Tips

This section describes tips for troubleshooting some common problems.

Sequence to Restart Your Network

Be sure to restart your network in this sequence:

1. Turn off and unplug the modem.
2. Turn off the router and computers.
3. Plug in the modem and turn it on. Wait 2 minutes.
4. Turn on the router and wait 2 minutes.
5. Turn on the computers.

Power LED

Check the Power LED to verify correct router operation.

If the Power LED does not turn solid green within 2 minutes after you turn the router on, reset the router according to the instructions in Factory Default Settings on page 114.

Check Ethernet Cable Connections

Make sure that the Ethernet cables are securely plugged in.

- The Internet LED on the router is on if the Ethernet cable connecting the wireless router and the modem is plugged in securely and the modem and router are turned on.
- If a powered-on computer is connected to the router by an Ethernet cable, the LAN LED is on.

Wireless Settings

Make sure that the wireless settings in the computer and router match exactly.

- For a wirelessly connected computer, the wireless network name (SSID) and wireless security settings of the router and wireless computer need to match exactly.
- If you set up an access list in the Advanced Wireless Settings screen, you have to add each wireless computer’s MAC address to the router’s access list.

Network Settings

Make sure that the network settings of the computer are correct.
Troubleshooting

Wired and wirelessly connected computers need to have network (IP) addresses on the same network as the router. The simplest way to do this is to configure each computer to obtain an IP address automatically using DHCP.

Some cable modem service providers require you to use the MAC address of the computer initially registered on the account. You can view the MAC address in the Attached Devices screen.

Troubleshooting with the LEDs

After you turn on power to the router, the following sequence of events should occur:

1. When power is first applied, verify that the Power LED is on.
2. After approximately 2 minutes, verify that:
   • The Power LED is solid green.
   • The Internet LED is on.
   • The Ethernet LAN LED is on if any local port is connected to a computer. This indicates that a link has been established to the connected device.

The LEDs on the front panel of the router can be used for troubleshooting.

Power LED Is Off or Blinking

• Make sure that the power cord is securely connected to your router and that the power adapter is securely connected to a functioning power outlet.
• Check that you are using the 12V DC, 2.5A power adapter that NETGEAR supplied for this product.
• If the Power LED blinks green every second, the router software is corrupted. This can happen if a firmware upgrade is interrupted, or if the router detects a problem with the firmware. If the error persists, you have a hardware problem. For recovery instructions, or help with a hardware problem, contact Technical Support at www.netgear.com/support.

LEDs Never Turn Off

When the router is turned on, the LEDs turn on for about 10 seconds and then turn off. If all the LEDs stay on, there is a fault within the router.

If all LEDs are still on 1 minute after power-up:
• Cycle the power to see if the router recovers.
• Clear the router’s configuration to factory defaults, as explained in Factory Default Settings on page 114.

If the error persists, you might have a hardware problem and should contact Technical Support at www.netgear.com/support.
Troubleshooting

Internet or Ethernet Port LEDs Are Off

If either the Ethernet port LEDs or the Internet LED does not light when the Ethernet connection is made, check the following:

• Make sure that the Ethernet cable connections are secure at the router and at the modem or computer.
• Make sure that power is turned on to the connected modem or computer.
• Be sure that you are using the correct cable.

When connecting the router’s Internet port to a cable or DSL modem, use the cable that was supplied with the cable or DSL modem. This cable could be a standard straight-through Ethernet cable or an Ethernet crossover cable.

Wireless LED Is Off

If the Wireless LED stays off, check to see if the Wireless On/Off button on the router has been pressed. This button turns the wireless radios in the router on and off. The 2.4 GHz and 5 GHz LEDs are lit when the wireless radio is turned on.

Cannot Log In to the Router

If you are unable to log in to the router from a computer on your local network, check the following:

• If you are using an Ethernet-connected computer, check the Ethernet connection between the computer and the router as described in the previous section.
• Make sure that your computer’s IP address is on the same subnet as the router. If you are using the recommended addressing scheme, your computer’s address should be in the range of 192.168.1.2 to 192.168.1.254.
• If your computer’s IP address is shown as 169.254.x.x, recent versions of Windows and MacOS will generate and assign an IP address if the computer cannot reach a DHCP server. These autogenerated addresses are in the range of 169.254.x.x. If your IP address is in this range, check the connection from the computer to the router, and reboot your computer.
• If your router’s IP address was changed and you do not know the current IP address, clear the router’s configuration to factory defaults. This sets the router’s IP address to 192.168.1.1. This procedure is explained in Factory Default Settings on page 114.
• Make sure that your browser has Java, JavaScript, or ActiveX enabled. If you are using Internet Explorer, click Refresh to be sure that the Java applet is loaded.
• Try quitting the browser and launching it again.
• Make sure that you are using the correct login information. The factory default login name is admin, and the password is password. Make sure that Caps Lock is off when you enter this information.
Cannot Access the Internet

If you can access your router but you are unable to access the Internet, first determine whether the router can obtain an IP address from your Internet service provider (ISP). Unless your ISP provides a fixed IP address, your router must request an IP address from the ISP. You can determine whether the request was successful using the Router Status screen.

To check the WAN IP address:

1. Start your browser, and select an external site such as http://www.netgear.com.
4. Check that an IP address is shown for the Internet port. If 0.0.0.0 is shown, your router has not obtained an IP address from your ISP.

If your router cannot obtain an IP address from the ISP, you might need to force your cable or DSL modem to recognize your new router by restarting your network.

If your router is still unable to obtain an IP address from the ISP, the problem might be one of the following:

- Your Internet service provider (ISP) might require a login program. Ask your ISP whether they require PPP over Ethernet (PPPoE) or some other type of login.
- If your ISP requires a login, the login name and password might be set incorrectly.
- Your ISP might check for your computer’s host name. Assign the computer host name of your ISP account as the account name in the Basic Settings screen.
- Your ISP allows only one Ethernet MAC address to connect to Internet and might check for your computer’s MAC address. In this case, do one of the following:
  - Inform your ISP that you have bought a new network device, and ask them to use the router’s MAC address.
  - Configure your router to clone your computer’s MAC address.

If your router can obtain an IP address, but your computer is unable to load any Web pages from the Internet:

- Your computer might not recognize any DNS server addresses.

  A DNS server is a host on the Internet that translates Internet names (such as www addresses) to numeric IP addresses. Typically, your ISP provides the addresses of one or two DNS servers for your use. If you entered a DNS address during the router’s configuration, reboot your computer, and verify the DNS address. You can configure your computer manually with DNS addresses, as explained in your operating system documentation.
- Your computer might not have the router configured as its TCP/IP gateway.
If your computer obtains its information from the router by DHCP, reboot the computer, and verify the gateway address.

- You might be running login software that is no longer needed.

If your ISP provided a program to log you in to the Internet (such as WinPoET), you no longer need to run that software after installing your router. You might need to go to Internet Explorer and select **Tools > Internet Options**, click the **Connections** tab, and select **Never dial a connection**.

**Changes Not Saved**

If the router does not save the changes you make in the router interface, check the following:

- When entering configuration settings, always click the **Apply** button before moving to another screen or tab, or your changes are lost.
- Click the **Refresh** or **Reload** button in the Web browser. The changes might have occurred, but the old settings might be in the Web browser’s cache.

**Incorrect Date or Time**

Select **Advanced > Security > Schedule** to display the current date and time. The router uses the Network Time Protocol (NTP) to obtain the current time from one of several network time servers on the Internet. Each entry in the log is stamped with the date and time of day. Problems with the date and time function can include the following:

- Date shown is January 1, 2000. This means the router has not yet successfully reached a network time server. Check that your Internet access is configured correctly. If you have just finished setting up the router, wait at least 5 minutes, and check the date and time again.
- Time is off by one hour. The router does not automatically sense daylight savings time. In the Schedule screen, select the **Automatically adjust for daylight savings time** check box.

**Wireless Connectivity**

If you are having trouble connecting wirelessly to the router, try to isolate the problem.

- Does the wireless device or computer that you are using find your wireless network?

  If not, check the 2.4 GHz and 5 GHz LEDs on the front of the router. They should be lit. If they aren’t, you can press the **Wireless** button on the front of the router to turn the router’s wireless radios back on.

  If you disabled the router’s SSID broadcast, then your wireless network is hidden and does not show up in your wireless client’s scanning list. (By default, SSID broadcast is enabled.)
• If your wireless device finds the network but you cannot join the network, check to make sure that your wireless device is compatible with the network that you selected (2.4 GHz or 5 GHz).

• Does your wireless device support the security that you are using for your wireless network (WPA or WPA2)?

• To check the wireless settings for the router, use an Ethernet cable to connect a computer to a LAN port on the router. Then log in to the router and look on the dashboard on the Basic Home screen:

![Dashboard Screenshot](image)

You can click the **Wireless** pane to view more details. Be sure to configure both sections (for 2.4 GHz b/g/n and 5 GHz a/n) on the Wireless Settings screen and to click **Apply** if you make changes.

**Wireless Signal Strength**

If your wireless device finds your network, but the signal strength is weak, check these conditions:

• Is your router too far from your computer, or too close? Place your computer near the router, but at least 6 feet away, and see whether the signal strength improves.

• Is your wireless signal blocked by objects between the router and your computer?
Supplemental Information

This appendix provides factory default settings, technical specifications for the N600 Wireless Dual Band Gigabit Router WNDRMAC, and links to related documents.

• Factory Default Settings
• Technical Specifications
Factory Default Settings

You can restore the factory default configuration settings to reset the router’s user name to admin, the password to password, and the IP address to www.routerlogin.net. This procedure erases your current configuration, including your wireless security settings, and restores the factory defaults. When you log in after resetting, the Smart Wizard configuration assistant prompts you to configure these settings.

To restore the factory default settings:

1. Use a sharp object such as a pen or a paper clip to press and hold the Restore Factory Settings button, located on the bottom of the router, for over 2 seconds until the Power LED turns to blinking amber.

2. Release the Restore Factory Settings button, and wait for the router to reboot.

The factory default settings are restored so that you can access the router from your Web browser using the factory defaults.

Table 4. WNDRMAC Router Default Configuration Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Router login URL</td>
<td><a href="http://www.routerlogin.net">www.routerlogin.net</a> or <a href="http://www.routerlogin.com">www.routerlogin.com</a></td>
</tr>
<tr>
<td>User name (case-sensitive) printed on product label</td>
<td>admin</td>
</tr>
<tr>
<td>Password (case-sensitive) printed on product label</td>
<td>password</td>
</tr>
<tr>
<td>Internet MAC address</td>
<td>Use default hardware address</td>
</tr>
<tr>
<td>MTU size</td>
<td>1500</td>
</tr>
<tr>
<td>Router LAN IP address printed on product label (gateway IP address)</td>
<td>192.168.1.1</td>
</tr>
<tr>
<td>Router subnet</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>DHCP server</td>
<td>Enabled</td>
</tr>
<tr>
<td>DHCP range</td>
<td>192.168.1.2 to 192.168.1.254</td>
</tr>
<tr>
<td>Time zone</td>
<td>Pacific time</td>
</tr>
<tr>
<td>Time zone daylight savings time</td>
<td>Disabled</td>
</tr>
<tr>
<td>Allow a registrar to configure this router</td>
<td>Enabled</td>
</tr>
<tr>
<td>Wireless communication</td>
<td>Enabled</td>
</tr>
<tr>
<td>Wireless network names (SSIDs)</td>
<td>• The unique default network name is printed on product label</td>
</tr>
<tr>
<td></td>
<td>• 2.4 GHz b/g/n guest network: NETGEAR-Guest</td>
</tr>
<tr>
<td></td>
<td>• 5 GHz a/n guest network: NETGEAR-5G-Guest</td>
</tr>
</tbody>
</table>
The unique default password is printed on product label.

Transmission speed

Country/region United States in the US; otherwise varies by region

RF channel 6 until region selected

Operating mode • 2.4GHz b/g/n: Up to 130 Mbps
• 5GHz a/n: Up to 300 Mbps

Data rate Best

Output power Full

Inbound (communications coming in from the Internet) Disabled (bars all unsolicited requests)

Outbound (communications going out to the Internet) Enabled (all)

* Maximum wireless signal rate derived from IEEE Standard 802.11 specifications. Actual throughput will vary. Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead, lower actual data throughput rate.
## Technical Specifications

### Table 5. WNDRMAC Router Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data and routing protocols</td>
<td>TCP/IP, RIP-1, RIP-2, DHCP, PPPoE, PPTP, Bigpond, Dynamic DNS, UPnP, and SMB</td>
</tr>
</tbody>
</table>
| Power adapter                        | • North America: 120V, 60 Hz, input  
• UK, Australia: 240V, 50 Hz, input  
• Europe: 230V, 50 Hz, input  
• All regions (output): 12V DC @ 2.5A, output |
| Dimensions                           | 1.1 in. x 6.89 in. x 4.68 in. (28 x 175 x 119 mm)                             |
| Weight                               | 1.2 lbs. (0.5 kg)                                                              |
| Operating temperature                | 0° to 40° C (32° to 104° F)                                                   |
| Operating humidity                   | 90% maximum relative humidity, noncondensing                                  |
| Meets requirements of               | • FCC Part 15 Class B  
• VCCI Class B  
• EN 55 022 (CISPR 22), Class B C-Tick N10947                                 |
| LAN                                  | 10BASE-T or 100BASE-Tx or 1000BASE-T, RJ-45                                   |
| WAN                                  | 10BASE-T or 100BASE-Tx or 1000BASE-T, RJ-45                                   |
| Wireless                             | Maximum wireless signal rate complies with the IEEE 802.11 standard.  
See the footnote for the previous table.                                      |
| Radio data rates                     | Auto rate sensing                                                             |
| Data encoding standards              | IEEE 802.11n, IEEE 802.11g, IEEE 802.11b 2.4 GHz  
IEEE 802.11n, IEEE 802.11a 5.0 GHz   |
| Maximum computers per wireless network | Limited by the amount of wireless network traffic generated by each node (typically 50–70 nodes). |
| Operating frequency ranges 2.4 Ghz   | 2.412–2.462 GHz (US)  
2.412–2.472 GHz (Japan)  
2.412–2.472 GHz (Europe ETSI)                                                     |
| Operating frequency ranges 5 Ghz     | 5.18–5.24 + 5.745–5.825 GHz (US)  
5.18–5.24 GHz (Europe ETSI)                                                       |
| 802.11 security                      | 40-bit (also called 64-bit) and 128-bit WEP, WPA-PSK, WPA2-PSK, and WPA/WPA2 Enterprise. |
Regulatory Compliance Information

This section includes user requirements for operating this product in accordance with National laws for usage of radio spectrum and operation of radio devices. Failure of the end-user to comply with the applicable requirements may result in unlawful operation and adverse action against the end-user by the applicable National regulatory authority.

Note: This product's firmware limits operation to only the channels allowed in a particular Region or Country. Therefore, all options described in this user's guide may not be available in your version of the product.

Europe - EU Declaration of Conformity

Marking by the above symbol indicates compliance with the Essential Requirements of the R&TTE Directive of the European Union (1999/5/EC). This equipment meets the following conformance standards:

EN300 328 (2.4Ghz), EN301 489-17, EN301 893 (5Ghz), EN60950-1

For complete DoC please visit the NETGEAR EU Declarations of Conformity website at: http://support.netgear.com/app/answers/detail/a_id/11621

EDOC in Languages of the European Community

<table>
<thead>
<tr>
<th>Language</th>
<th>Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cesky [Czech]</td>
<td>NETGEAR Inc. tímto prohlašuje, že tento Radiolan je ve shode se základními požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.</td>
</tr>
<tr>
<td>Dansk [Danish]</td>
<td>Undertegnede NETGEAR Inc. erklærer herved, at følgende udstyr Radiolan overholder de væsentlige krav og øvrige relevante krav i direktiv 1999/5/EF.</td>
</tr>
<tr>
<td>English</td>
<td>Hereby, NETGEAR Inc., declares that this Radiolan is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.</td>
</tr>
<tr>
<td>Language</td>
<td>Text</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Español [Spanish]</td>
<td>Por medio de la presente NETGEAR Inc. declara que el Radiolan cumple con los requisitos esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.</td>
</tr>
<tr>
<td>Ελληνική [Greek]</td>
<td>ΕΛΛΗΝΙΚΗ ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ NETGEAR Inc. ΔΗΛΑΔΩΝΕΙ ΟΤΙ Radiolan ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.</td>
</tr>
<tr>
<td>Français [French]</td>
<td>Par la présente NETGEAR Inc. déclare que l’appareil Radiolan est conforme aux exigences essentielles et aux autres dispositions pertinentes de la directive 1999/5/CE.</td>
</tr>
<tr>
<td>Italiano [Italian]</td>
<td>Con la presente NETGEAR Inc. dichiara che questo Radiolan è conforme ai requisiti essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.</td>
</tr>
<tr>
<td>Nederlands [Dutch]</td>
<td>Hierbij verklaart NETGEAR Inc. dat het toestel Radiolan in overeenstemming is met de essentiële eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.</td>
</tr>
<tr>
<td>Magyar [Hungarian]</td>
<td>Alulírott, NETGEAR Inc. nyilatkozom, hogy a Radiolan megfelel a vonatkozó alapvető követelményeknek és az 1999/5/EC irányelv egyéb előírásainak.</td>
</tr>
<tr>
<td>Polski [Polish]</td>
<td>Niniejszym NETGEAR Inc. oświadcza, że Radiolan jest zgodny z zasadniczymi wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/EC.</td>
</tr>
<tr>
<td>Português [Portuguese]</td>
<td>NETGEAR Inc. declara que este Radiolan está conforme com os requisitos essenciais e outras disposições da Directiva 1999/5/CE.</td>
</tr>
<tr>
<td>Slovensko [Slovenian]</td>
<td>NETGEAR Inc. izjavlja, da je ta Radiolan v skladu z bistvenimi zahtevami in ostalimi relevantnimi določili direktive 1999/5/ES.</td>
</tr>
<tr>
<td>Slovensky [Slovak]</td>
<td>NETGEAR Inc. týmto vyhlasuje, že Radiolan splňa základné požiadavky a všetky príslušné ustanovenia Smernice 1999/5/ES.</td>
</tr>
<tr>
<td>Svenska [Swedish]</td>
<td>Häremed intygar NETGEAR Inc. att denna Radiolan står i överensstämmelse med de väsentliga egenskapskrav och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG.</td>
</tr>
</tbody>
</table>
This device is a 2.4 GHz wideband transmission system (transceiver), intended for use in all EU member states and EFTA countries, except in France and Italy where restrictive use applies.

In Italy the end-user should apply for a license at the national spectrum authorities in order to obtain authorization to use the device for setting up outdoor radio links and/or for supplying public access to telecommunications and/or network services.

This device may not be used for setting up outdoor radio links in France and in some areas the RF output power may be limited to 10 mW EIRP in the frequency range of 2454 - 2483.5 MHz. For detailed information the end-user should contact the national spectrum authority in France.

**FCC Requirements for Operation in the United States**

**FCC Information to User**

This product does not contain any user serviceable components and is to be used with approved antennas only. Any product changes or modifications will invalidate all applicable regulatory certifications and approvals.

**FCC Guidelines for Human Exposure**

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with minimum distance of 20 cm between the radiator and your body. This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

**FCC Declaration of Conformity**

We, NETGEAR, Inc., 350 East Plumeria Drive, San Jose, CA 95134, declare under our sole responsibility that the N600 Wireless Dual Band Gigabit Router WNDRMAC complies with Part 15 Subpart B of FCC CFR47 Rules. Operation is subject to the following two conditions:

- This device may not cause harmful interference, and
- This device must accept any interference received, including interference that may cause undesired operation.

**FCC Radio Frequency Interference Warnings & Instructions**

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following methods:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an electrical outlet on a circuit different from that which the radio receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

**FCC Caution**

Any changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate this equipment.
• This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
• For product available in the USA market, only channel 1~11 can be operated. Selection of other channels is not possible.
• This device and its antenna(s) must not be co-located or operation in conjunction with any other antenna or transmitter.

Industry Canada
This device complies with RSS-210 of the Industry Canada Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE: Radiation Exposure Statement:
This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with minimum distance 20cm between the radiator & your body.

Caution:
The device for the band 5150-5250 MHz is only for indoor usage to reduce potential for harmful interference to co-channel mobile satellite systems.

High power radars are allocated as primary users (meaning they have priority) of 5250-5350 MHz and 5650-5850 MHz and these radars could cause interference and/or damage to LE-LAN devices.

Ce dispositif est conforme à la norme CNR-210 d'Industrie Canada applicable aux appareils radio exempts de licence. Son fonctionnement est sujet aux deux conditions suivantes: (1) le dispositif ne doit pas produire de brouillage préjudiciable, et (2) ce dispositif doit accepter tout brouillage reçu, y compris un brouillage susceptible de provoquer un fonctionnement indésirable.

NOTE IMPORTANT: Déclaration d'exposition aux radiations:
Cet équipement est conforme aux limites d'exposition aux rayonnements IC établies pour un environnement non contrôlé. Cet équipement doit être installé et utilisé avec un minimum de 20 cm de distance entre la source de rayonnement et votre corps.

Avertissement:
Le dispositif fonctionnant dans la bande 5150-5250 MHz est réservé uniquement pour une utili-sation à l'intérieur afin de réduire les risques de brouillage préjudiciable aux systèmes de satellites mobiles utilisant les mêmes canaux.

Les utilisateurs de radars de haute puissance sont désignés utilisateurs principaux (c.-à-d., qu'ils ont la priorité) pour les bandes 5250-5350 MHz et 5650-5850 MHz et que ces radars pourraient causer du brouillage et/ou des dommages aux dispositifs LAN-EL.
Index

A
access
  remote 101
  viewing logs 68
access points 84
accessing remote computer 88
adding
custom service 93
  priority rules 41
address reservation 39
advertisement period 103
alerts, emailing 60
applications, QoS for online gaming 41
approved USB devices 54
attached devices 22
authentication, required by mail server 60
automatic firmware checking 63
automatic Internet connection 31

B
back panel 10
backing up configuration 69
base station, setting up 86
Basic Settings screen 20
blocking
  inbound traffic 88
  keywords 57
  sites 57
blocking services 58
blocking, keywords, examples 57
box contents 8

C
cables, checking 107
changes not saved, router 111
compliance 117
configuration file 69
configuring
  DMZ server 35
  Dynamic DNS 98
  NAT 34
  port forwarding 92
  port triggering 95
  QoS 40
  repeater unit 87
  user-defined services 58
  connecting wirelessly 12
  country setting 31
crossover cable 109
  CTS/RTS Threshold 83
custom service (port forwarding) 93

dashboard 17
data packets, fragmented 35
date and time 111
daylight savings time 111
default DMZ server 35
default factory settings, restoring 69, 114
default gateway 66
deleting
  configuration 69
  keywords 57
denial of service (DoS) protection 56
devices, attached 22
DHCP server 38, 66
DHCP setting 65
DMZ server 35
DNS addresses, troubleshooting 110
DNS servers 88
Domain Name Server (DNS) addresses 21, 65
Dynamic DNS 97
DynDNS.org 97

E
email notices 60
encryption keys 29
erasing configuration 69
Ethernet (LAN) LED
described 11
troubleshooting and 108, 109
Ethernet cables, checking 107
F
factory default settings, restoring 69, 114
file sharing 46
firmware version 64
firmware, upgrading 16, 63
Fragmentation Length 83
fragmented data packets 35
front panel 11

G
games, online, QoS for 41
gateway IP address 21
Genie, NETGEAR 15
guest networks 27, 67

H
host name 20
host, trusted 57

I
inbound traffic, allowing or blocking 88
installing
NETGEAR Genie 15
Setup Wizard 31
Internet connection
setting up 20
troubleshooting 110
Internet LED
described 11
troubleshooting and 108
Internet port 31, 64
Internet Relay Chat (IRC) 90
Internet service provider (ISP)
account information 14
Basic Settings screen 20
login 14
Internet services, blocking access 58
interval, poll 65
IP addresses
current 64
DHCP 14
dynamic 97
reserved 39
IP subnet mask 65

K
keywords 57

L
label, product 10
LAN LED
described 11
LAN port
QoS for 42
settings 64
LAN setup 37
language setting 31
large files, sharing 47
lease, DHCP 66
LEDs 11
local servers, port forwarding to 92
logging in 14, 16
logs
emailing 60
viewing 68

M
MAC addresses
current 64
product label 10
QoS for 43
mail server, outgoing 60
maintenance settings 62
managing router remotely 101
media server, setting the router to be a 53
menus, described 17
metric value 100
mixed mode security options 29
MTU size 35
multicasting 38

N
NAT (Network Address Translation) 34, 35, 89
NETGEAR Genie 15
network
correct settings, checking 107
restarting 107
Network Time Protocol (NTP) 111
networks
guest 67
networks, guest 27

O
outgoing mail server 60
P
packets, fragmented 35
Parental Controls 23
passphrases
  changing 26
  product label 10
password recovery, admin 70
passwords, see passphrases
photos, sharing 47
poll interval 65
port filtering 58
port forwarding 88, 90, 91, 92
port numbers 58
port status 65
port triggering 88, 89, 91, 95
ports, listed, back panel 10
positioning the router 12
Power LED
  described 11
  troubleshooting and 108
PPPoE (PPP over Ethernet) 110
Preamble mode 83
preset security
  about 24
  passphrase 26
pre-shared key 32
primary DNS addresses 21
printing files and photos 47
prioritizing traffic 40
Push ‘N’ Connect 18

Q
QoS (Quality of Service) 40

R
radio, wireless 83
RADIUS server 29
range of wireless connections 12
ReadySHARE access 46, 50
recovering admin password 70
releasing connection status 66
remote management 101
renewing connection status 66
repeater units 87
reserved IP adresses 39
restarting network 107
restoring
  configuration file 69
    default factory settings 69, 114
  router interface, described 17
  router status, viewing 64

S
scheduling keyword and service blocking 60
secondary DNS 21
security 24
  firewall settings 56
  see also security options
security options 28
security PIN 32
sending logs by email 60
serial number, product label 10
services, blocking 58
services, blocking Internet 58
settings, factory default 113
Setup Wizard 31
sharing files 46
sites, blocking 57
SMTP server 60
specifications, technical 113
SSID
  described 26
  product label 10
static routes 99
status lights 11
status, router, viewing 64
subnet mask 65
system up time 65

T
technical specifications 113
technical support 2
Temporal Key Integrity Protocol (TKIP) 29
time of day 111
time to live, advertisement 103
time-out, port triggering 96
trademarks 2
traffic metering 104
troubleshooting 106
  date or time incorrect 111
  log in access 109
  router changes not saved 111
  trusted host 57
Universal Plug and Play (UPnP) 102
up time, system 65
upgrading firmware 16, 63
USB
    advanced configuration 51
    basic storage settings 48
    drive requirements 46
    file sharing 46
    ReadySHARE access 46, 50
    remote computer connection 54
    specifying approved devices 54
    unmounting a USB drive 53
USB devices, approved 54
USB LED
described 11
user-defined services 58

viewing
    logs 68
    router status 64

WAN IP address, troubleshooting 110
WAN setup 34
Wi-Fi Protected Setup (WPS) 18, 32
devices, adding 18
Wired Equivalent Privacy (WEP) encryption 29
wireless channel 26
wireless connections 12
wireless connections, troubleshooting 111
wireless devices
    adding to the network 17
Wireless Distribution System (WDS) 84, 85
Wireless LED
described 11
troubleshooting and 109, 110
wireless mode 26
wireless network name 10
wireless network name (SSID) broadcast 26
wireless network name (SSID), described 26
wireless network settings 26
wireless radio 83
wireless repeating 84, 85
    base station 86
    repeater unit 87
wireless security options 28
wireless settings 68
    checking for correct 107
    SSID broadcast 26
Wireless Settings screen 24
WMM (Wi-Fi Multimedia) 40
WPA encryption 29
WPA2 encryption 29
WPA2-PSK encryption 29
WPA-802.1x encryption 29
    RADIUS servers 29
WPA-PSK encryption 29
WPA-PSK/WPA2-PSK mixed mode 29
WPS button 18
WPS-PSK encryption 29
WPS-PSK+WPA2-PSK encryption 29
wrong date or time 111